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This chapter is intended to give you a broad overview of Microsoft Producer and what 
you can accomplish using it. Our goal is to explain how the features in Producer help 
you to create dynamic, rich-media presentations�ones that let you go beyond using 
simple text and images. 

Producer lets you share your message with others through the Web, through a 
corporate intranet or extranet, or through a third-party e-service provider. You can 
easily incorporate audio, video, HTML files, and still images with your Microsoft 
PowerPoint presentations to create dynamic, distributable, rich-media presentations. 

What Can I Do with Producer? 

You can install and run Producer on a computer that is running the Microsoft 
Windows 2000 or Windows XP operating system and PowerPoint 2002. Producer is a 
standalone application that lets you take your PowerPoint slides and synchronize 
them with audio and video. This can be audio and video that you have already 
recorded on your computer or new audio and video content that you record in 
Producer. Furthermore, you can add still images and HTML files to your 
presentations. 

The final product is a rich-media presentation that you can distribute on a company 
intranet site, on an e-service provider�s site, on a CD, or to the Web so clients, 
colleagues, or anyone with Microsoft Internet Explorer can watch. 

 
Note 
You can import 
existing media files 
into Producer to use 
in your presentations. 
And you can also 
record original video 
and audio in 
Producer. To use the 
recording features, 
however, you must 
have the appropriate 
video and audio 
capture hardware 
installed on your 
computer. See the 
Playing and 
Recording Digital 
Media booklet to 
learn about the 
hardware you�ll need 
and how to set it up. 
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Working with Producer, you can create a variety of presentations based on your 
specific needs. Later in this chapter, you will see a list of different scenarios in which 
you might use Producer. 

Figure 1-1 shows a presentation that is being edited in Producer. 

 

 
Figure 1-1   Editing a presentation in Producer. 

Working with Producer 

Before you start working with Producer and this book, it�s helpful to know what 
features are included in Producer and where they are discussed in this book. The 
following section is designed to do just that. 

Getting Content into Producer 

The first task is to bring digital media files into your Producer project. The files that 
you can use in your projects can include audio, video, PowerPoint slides, still images, 
and HTML files. 

Because you can import a wide variety of digital media file formats, you will be able to 
use many of your existing still images, HTML files, audio files, video files, or 
PowerPoint slides.  

You can capture audio and video in Producer if you have an appropriate capture 
device connected to or installed in your computer. You can record from a wide variety 
of video capture devices, such as Web cameras, analog video cameras, digital video 
(DV) cameras, and analog or DV VCRs. These features enable you to capture full-
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motion video�either live or from tape�or to simply capture individual still images 
from video. 

You can also use a standalone audio capture device such as a microphone to 
capture audio. If you plan to capture audio and video using an analog or DV camera 
or VCR, you need to have a video capture card connected and properly installed on 
your computer.  

If a capture device is properly installed and detected on your computer, you can then 
record video and audio in Producer. The video and audio you record play an 
important role in the presentations you create; they�re one of the key elements that 
helps turn your standard, old-fashioned slide shows into dynamic, rich-media 
presentations. 

Other capturing options include recording video and audio (or audio only) alongside 
your PowerPoint slides or recording video or still images of your computer screen. 

Regardless of the recording you want to make for your presentation, the Capture 
Wizard walks you step-by-step through the capturing process and lets you choose 
what type of recording you want to make. The type of content you capture is up to 
you.  

Editing in Producer 

After you have imported digital media files or recorded the video and audio you want 
to use in your presentation, you can then begin arranging them in your project. You 
start by adding them to the timeline. The timeline is the Producer workspace in which 
you arrange the various elements that will appear in your presentation. The timeline 
enables you to edit the entire project or elements of the project, such as individual 
audio and video files. 

When working with video and audio, you will often need to edit or hide some 
unwanted material. For example, a video file might contain the frantic preparation 
and last-minute changes that took place during recording. You probably won�t want to 
show this part in your presentation. However, you might not want to delete those last-
minute changes because they could be used for a separate training video. 

You can use Producer to trim unwanted video and audio out of your presentation. 
This lets you hide the unwanted footage from your audience without deleting those 
scenes from the source video file.  

To aid in synchronizing slides with audio and video, Producer provides a timeline 
workspace. Once you have the files for your presentation laid out on the timeline, you 
may want to rearrange the digital media files. You can quickly do this by dragging the 
files from one part of the timeline to another or by using the menu commands to cut, 
copy, and paste files. And if you later decide that you have a file on the timeline that 
you do not need anymore, you can easily remove that file from the timeline so it does 
not appear in your final presentation.  

In addition to editing video footage, you can enhance your presentations by adding 
video transitions and effects. Producer provides many different video transitions and 
effects that you can add to your presentation. A video transition plays between two 
video clips, slides, or still images, while a video effect applies a new style or 
appearance to your still images or video content.  
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To help your audience understand the topics discussed in your presentation, you can 
create a table of contents. The table of contents in your presentation is much like the 
table of contents you see in a book; it provides a way for your audience to see the 
topics or subjects that will be discussed. Just like a table of contents in a book lists 
page numbers for chapters or topics, the table of contents for your presentation 
contains links to a specific topic or part of your presentation. This way, viewers can 
simply click a link to go to that part of the presentation. When they click a table of 
contents link, they will go to the corresponding video, text, images, or PowerPoint 
slides that are contained in that topic.  

Synchronizing Your Presentation 

You can choose to synchronize existing video and audio files with your PowerPoint 
slides. This is an important feature of Producer because it lets you take different 
digital media files, such as audio, video, still images, and slides, and then quickly 
synchronize them to create a rich-media presentation. Synchronizing is done through 
the synchronize slides feature.  

In addition to synchronizing existing audio and video files with your slides, you can 
also choose to capture new video and audio while synchronizing it with your 
PowerPoint slides. You can do this by narrating your slides to video with audio or 
audio only in the Capture Wizard.  

Previewing Your Presentation 

As you work on your project in Producer, you can preview it to see how the 
presentation will appear after you publish it. By previewing, you can get a �sneak 
peek� of your project before publishing it to a local computer, Web server, Windows 
Media server, or e-service provider. 

Producer lets you preview in two different tabs: the Media tab and the Preview 
Presentation tab. Each tab gives you a different view of your presentation.  

Publishing Your Presentation 

When you have finished editing your project, you are then ready to publish the 
presentation. When you publish the project as a presentation, all of the digital media 
in your project, including any video, audio, HTML files, PowerPoint slides, and 
templates, is compiled into one final presentation. You can then take the final 
presentation and the files contained in it and publish it to a local computer, Web 
server, Windows Media server, e-service provider, or even to a CD that you can then 
distribute. 
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What Other Software Works with Producer? 

You can use many different types of digital media in your presentations. The 
presentations you create can use still images, HTML files, PowerPoint slides, video, 
and audio. The software you use to create these original files is completely up to you, 
as long as you can save the source files in file formats that can be imported into 
Producer. 

For example, you can create your HTML files by using a WYSIWIG (What You See Is 
What You Get) HTML editor, such as Microsoft FrontPage, or you can use a simple 
text editor, such as Notepad. As long as the software you choose lets you save in a 
supported file format, you can use the applications you are most comfortable with to 
create the original still images, video, audio, and HTML files you want to use in your 
Producer presentations. 

You can use slides that were created by any version of PowerPoint, but to run 
Producer and import PowerPoint slides to your Producer presentations, you must 
have PowerPoint 2002 installed on your computer. 

To watch your published Producer presentation, both you and your audience must 
have Windows Media Player 6-4 or higher installed�Windows Media Player 7.0 or 
higher is recommended. In addition to having Windows Media Player installed, 
Internet Explorer 5.0 or higher is needed to view your published presentation. 

What Hardware Can I Use with Producer? 

Recording video and audio for your Producer presentations requires you to have 
specific hardware properly installed and connected to your computer. To record audio 
and video for your presentations, you need to have video and audio capture devices 
installed on your computer. 

Video Capture Devices 

To record video in Producer, you must have an appropriate capture device connected 
to and recognized by your computer. A capture device is a piece of hardware, such as 
a Web camera, a VCR, or an analog or digital video (DV) camera that lets you record 
video to your computer. 

To record video and audio to your computer using a DV or analog camera or VCR, you 
must use a video capture device, such as a video capture card, that is installed on 
your computer. If you plan to use an analog video camera, you will need to use an 
analog capture device. However, if you have a DV camera, you can use an analog or 
digital capture card. An IEEE 1394 DV capture card, sometimes called a FireWire 
card, can be used to transfer digital video from your camera, whether live or from 
tape, to your computer. 
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Today, some new computers already include a video capture device, such as FireWire 
card, to connect your DV camera or VCR. However, a majority of computers require 
that a separate video capture card or device be installed on your computer. 

Audio Capture Devices 

Just like you need a video capture device to record video to your computer, you also 
need to have an audio capture device, such as an audio card, connected and 
properly detected by your computer to record audio. Many sound cards let you 
connect an external audio capture device such as a microphone to your computer, so 
you can record audio on your computer. 

Your Presentation: The Final Product 

The final product of your project is the published presentation. This contains all of the 
different digital media files and effects you added to your Producer project, and is the 
presentation that your audience can watch in their Web browsers. The final 
presentation is created by publishing the project. The presentation can be published 
to a variety of locations including a Web site, corporate intranet site, a shared 
network location, your local computer, or to a recordable or rewriteable CD.  

Understanding Windows Media Technologies 

When you record video and audio in Producer, it is encoded into Windows Media 
Format. Audio and video files in Windows Media Format can be streamed from a 
Windows Media server, which means that the audio and video can be seen or 
listened to while the file is being delivered to the viewer�s computer. These files also 
can contain links from the audio or video to slides or other files. This is how the slides 
or other files stay synchronized with the video or audio. 

Typical multimedia files like AVI or WAV files cannot be synchronized with other files 
easily, which is why Windows Media Format is used. Any audio and video in your final 
published presentation is saved in Windows Media Format. 

Windows Media lets you easily distribute high-quality audio and video over a network, 
such as a corporate intranet or Web site. This is because high-quality Windows Media 
files are much smaller than original audio or video files in most other formats. 

Streaming Media 

Traditionally, audio and video needed to be downloaded to your computer before it 
could be played. However, Windows Media changes this by enabling streaming audio 
and video. Instead of having to wait a long time for a file to be completely downloaded, 
video and audio in Windows Media Format can be played as the file is delivered, or 
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streamed, to the local machine. This eliminates the �download and wait� issues that 
used to be associated with retrieving audio and video from the Internet. 

In addition, a streamed file does not remain on the user�s computer. The audio or 
video data is transferred to the user�s computer and played, but never saved to a file; 
users have to access the original source of the streaming audio or video every time 
they want to access it. This functionality gives content creators more control over how 
and when their content is used. 

Windows Media Tools 

The following sections describe some of the Windows Media software that you are likely 
to encounter when working with Producer. These tools are not required to create 
successful presentations, but you might want to know about them anyway. 

Windows Media Player 

Windows Media Player is the software that lets you play Windows Media files on your 
computer. The audio and video files you play in Windows Media Player can be stored 
locally on your computer, or you can play Windows Media files that are streamed 
from a media server or downloaded from a Web server. Additionally, you can play 
other popular audio file types such as MP3, and other video file types such as AVI or 
MPEG. You can also use Windows Media Player to listen to Internet radio stations 
from around the world. 

In addition to playing music, Windows Media Player acts as an entertainment center 
for your computer. You can use Windows Media Player to organize all the video and 
audio you have on your computer. You can copy CDs to your computer to save new 
music in Windows Media Format, and you can create (burn) CDs from lists of songs 
stored in Windows Media Player. 

Windows Media Services 

Windows Media Services lets you stream and distribute digital media files over the 
Internet or over a local network. A computer running Windows Media Services is 
known as a Windows Media server. This server is much like a Web server, but it can 
be used to distribute streaming digital media content over the Internet or a local 
network. 

A Windows Media server is designed to distribute Windows Media files by streaming 
them across a network. Streaming eliminates the traditional �download and wait� 
experience that occurs when a Windows Media Format file is stored on and 
distributed from a Web server. 

If you have Windows Media Services installed on a computer running Windows 2000 
Server, you can set up this service to distribute Windows Media files over your 
corporate network or over the Internet. This server hosts Windows Media-based files 
that are stored on the computer, and you can also broadcast live events. 
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Windows Media Encoder 

Windows Media Encoder lets you encode video and audio content from a Web 
camera, DV camera, analog video camera, or a DV or analog VCR connected to a 
capture device on your computer. The video you encode using Windows Media 
Encoder can be taken from a source such as a video camera or from tape, and it is 
encoded into Windows Media Format. In addition to recording from a camera or VCR, 
you can also record video screen captures�video of the actions that occur on your 
computer screen�into Windows Media files. 

When you encode content using Windows Media Encoder, you can choose to record 
both audio and video, or audio only. You can encode to a file, to a live broadcast 
stream, or to both at the same time. 

In addition to encoding content live or from tape, you can also use Windows Media 
Encoder to encode (and broadcast, if necessary) existing audio and video files into 
Windows Media Format. 

Windows Media Encoder also lets you deliver a live stream. This lets users watch or 
listen to the content you are encoding and streaming using Windows Media Player. If 
your audience consists of 50 people or less and you want to stream live content, you 
can use Windows Media Encoder as an alternative to using Windows Media Services 
to stream and distribute the content. 

A software development kit (SDK) is available for Windows Media Encoder. This SDK 
enables software developers to use Microsoft Visual Basic or C++ to build 
customized applications that incorporate Windows Media encoding technologies. 

You can use any existing content you may have already encoded using Windows 
Media Encoder and then import it directly into Producer. This lets you use existing 
audio and video files that you have already encoded in your Producer presentations. 

How Is Producer Different from PowerPoint? 

A question that you might be asking is �How is Producer different from PowerPoint?� 
Well, that question is pretty easy to answer. You use PowerPoint to create slides (and 
HTML files) that can serve as the basic building blocks for your final presentation in 
Producer. PowerPoint lets you create versatile slideshows and presentations that can 
be used on their own or incorporated into a presentation using Producer. 

You then import what you have added in PowerPoint into Producer and combine your 
PowerPoint creation with other types of digital media to create rich-media 
presentations. 

In Producer, you can take the PowerPoint presentation and enhance it by adding 
video, audio, HTML files, effects, or transitions, and then synchronize these with your 
original PowerPoint slides. The final result is a seamless, rich-media presentation 
that you can deliver over a corporate network, intranet, extranet, CD, or Web site to 
effectively communicate your message. 
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The Producer user interface is designed to help you immediately start making 
presentations. The basic elements of the user interface include menus, a toolbar, 
tabs, and a timeline. This chapter will give you a quick introduction to the Producer 
interface. More extensive information is provided by the Producer Help. 

Using the Menus 

You can perform common tasks in Producer by selecting commands from the menus. 
For example, Figure 2-1 shows the New Presentation Wizard command being 
selected from the File menu. 
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Figure 2-1   Selecting the New Presentation Wizard command. 

The following sections provide brief descriptions of the menu commands. When 
applicable, the shortcut keys for the specific command appear in parentheses. 

File Menu 

The FIle menu provides commands that help you create new projects or work with 
existing projects you have created in Microsoft Producer. 

• New (Ctrl+N) Use this command to start a new project. When you use this 
command to create a new project, the timeline is empty. You can then 
import existing digital media files, or capture new audio and video files, and 
add them to the timeline. 

• New Presentation Wizard  Use this command to start the New Presentation 
Wizard that walks you through the process of creating and adding digital 
media to a new project. The New Presentation Wizard, shown in Figure 2-2, 
lets you choose a template for your presentation and import existing digital 
media files or record new audio and video. The wizard automatically adds 
the imported or recorded content to the timeline for your current project, 
which you can then edit and rearrange. 
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Figure 2-2   The introduction page of the New Presentation Wizard. 

• Open (Ctrl+O)  Use this command to open an existing Producer project. 
Project files in Producer have a .MSProducer file name extension. After you 
open the project, all of the associated digital media files appear in the Media 
tab, and any files that have been added to the timeline are displayed there. 

• Save Project (Ctrl+S)  Use this command to save the changes you made to 
the current project. By saving the project, you will record any changes you 
have made to the project, including any files you placed on the timeline and 
all the imported or recorded digital media. When you open the project later, 
you can continue working from where you last saved the project file. 

• Save As  Use this command to save an existing project with a new name or 
to a different location. This lets you start working on the existing project later 
without having to import, capture, add, or arrange existing digital media files 
in the project again. 

• Pack And Go  Use Pack And Go to archive your projects for migration to 
another computer for additional work or for storage. The project archive 
contains copies of all files used in the project and all timeline settings. You 
can then unpack the project archive on another computer and continue 
editing the project. 

• Publish Presentation (Ctrl+U)  Use this command to start the Publish 
Wizard. The Publish Wizard lets you publish the current project to a 
corporate intranet site, extranet site, Web site, CD, or third-party e-service 
provider. After you publish your presentation, others can then watch it in 
their Web browsers on the site to which you have published the 
presentation. 

• Import (Ctrl+I)  Use this command to import existing digital media files, such 
as still images, PowerPoint slides, HTML files, audio, or video files, into your 
current project. Whether you created your project through the New 
Presentation Wizard or you opened an existing project file, you can import 
additional digital media to use in the current project. 
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• Add Web Link  Use this command to insert a live Web page or a link to a live 
Web page in your presentation. A Web link lets you incorporate live Web 
content into your presentation. 

• Properties  Use this command to view information about the current project, 
including when the project was created and modified, as well as display 
presentation information such as the title, presenter name, and description 
of the presentation. In the Properties dialog box, you can also preview the 
estimated amount of disk space required to store your presentation based 
on different audience connection speeds, and see estimates of the amount 
of time your audience would have to wait to watch your presentation based 
on their connection speed. 

• Recent Projects  At the bottom of the File menu is a list of projects you have 
worked on recently. You can click one of these to open a specific project in 
Producer�as an alternative to using the Open command on the File menu. 

Edit Menu   

The Edit menu lets you make changes to your existing project and to digital media 
files in Producer. The following commands are on the Edit menu. 

• Undo (Ctrl+Z)  Use this command to undo the most recent task or action in 
Producer. 

• Redo (Ctrl+Y)  Use this command to redo the last undone action. For 
example, if you imported a file and then used the Undo command to un-
import the file, and you then changed your mind that you do want to import 
that file, you could click Redo to re-import the file. 

• Cut (Ctrl+X)  Use this command to move a file from one part of the timeline 
to another. When you use the Cut command, the file will be removed from 
the timeline. You can then use the Paste command to insert the file on a 
new part of the timeline. 

• Copy (Ctrl+C)  Use this command to copy a file from the contents pane to 
the timeline or from one part of the timeline to another. When you use the 
Copy command, the file is copied to the Clipboard. You can then use the 
Paste command to insert a copy of the file on the timeline. 

• Paste (Ctrl+V)  Use this command to paste a file you have copied or cut in 
Producer to the timeline. 

• Delete (Del)  Use this command to delete the current selection. The current 
selection may include one file, many files, or selected text. 

• Clear Timeline (Ctrl+Del)  Use this command to remove all files from the 
timeline. This is useful if you decide you want to start over without having to 
create a new project and import or capture digital media files again. 

• Select All (Ctrl+A)  Use this command to select all the files in a specified 
area. For example, if you last clicked on the Video track of the timeline and 
used the Select All command, all of the files on the Video track would be 
selected. 
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• Rename (F2)  Use this command to rename a selected item in the contents 
pane of the Media tab. For example, you can rename clips that are created 
from video files. 

• Edit Slide  Use this command to edit PowerPoint slides that have been 
imported into Producer. When you choose this command, PowerPoint starts 
so you can edit your PowerPoint presentation. You can edit a PowerPoint 
presentation with a .ppt file name extension or a presentation that was 
saved in PowerPoint as a Web page with an .htm file name extension. 

• Replace Web Link  Use this command to replace a live Web page or a link to 
a live Web page that is selected in your presentation. This command lets you 
change the Web address or the link that is displayed. 

• Presentation Scheme  Use this command to open the Presentation Scheme 
dialog box. You can then specify the font, font size, and colors that are 
displayed in the presentation. 

View Menu 

The View menu provides commands that enable you to switch between the different 
tabs, show or hide the toolbar, status bar, or timeline, and specify how icons are 
displayed in the Media tab. The following commands are on the View menu in 
Producer. 

• Media Tab (Ctrl+1)  Use this command to display the Media tab, which 
shows all the digital media files available in your current project. This 
includes any imported or recorded audio and video, as well as any imported 
still images, HTML files, and PowerPoint presentations. For all projects, 
standard folders that contain presentation templates, video transitions, and 
video effects are also displayed. The Media tab is discussed later in this 
chapter. 

• Table Of Contents Tab (Ctrl+2)  Use this command to display the Table Of 
Contents tab, which allows you to see and edit table of contents entries and 
information that displays on the introduction page of your presentation. The 
Table Of Contents tab is discussed later in this chapter. 

• Preview Presentation Tab (Ctrl+3)  Use this command to display the 
Preview Presentation tab, which lets you preview your project as it will 
appear after it has been published. The Preview Presentation tab is 
discussed in more detail later in this chapter. 

• Timeline (Ctrl+T)  Use this command to show or hide the timeline, which is 
shown in Figure 2-3. 
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Figure 2-3   The timeline in Producer. 

• Toolbar  Use this command to show or hide the Producer toolbar. The 
toolbar is displayed below the menus. 

• Status Bar  Use this command to show or hide the status bar. The status bar 
is displayed under the timeline, and it provides a description of a menu 
command when you point to or select one. 

• Thumbnails  Use this command to display small bitmap images, called 
thumbnails, of the digital media files in the Media tab. 

• Large Icons  Use this command to display large icons that indicate the file 
type for files in the Media tab. 

• Details  Use this command to see detailed information about imported 
digital media files in the Media tab. 

• Arrange Icons By  Use this command to display files in the Media tab 
according to various file properties. The properties you can sort by depend 
on the selected folder in Producer. For example, if you select the Video 
folder, you can arrange files based on information such as the name, source 
size, duration, type, date, dimensions, frame rate, or the source location of 
the files. 

• Refresh (F5)  Use this command to refresh the view of the current project. 

• Zoom Timeline In (Alt++)  Use this command to decrease the time interval 
shown on the timeline. This lets you see more precise timing information 
about the arrangement of the files added to the timeline. 

• Zoom Timeline Out (Alt+-)  Use this command to increase the time interval 
shown on the timeline. This lets you see more general information about the 
arrangement of the files added to the timeline. 

• Zoom To Fit  Use this command to have Producer automatically adjust the 
zoom level of the timeline so all of the timeline contents display on the 
timeline on your computer screen. This prevents you from needing to scroll 
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across the screen using the horizontal scroll bar to see all the contents on 
the timeline. 

Tools Menu 

The Tools menu provides commands for you to use when creating and editing your 
projects in Producer. The following commands are on the Tools menu. 

• Capture (Ctrl+R)  Use this command to start the Capture Wizard, which you 
can use to capture new audio, video, and still images in Producer. 

• Synchronize  Use this command to synchronize slides on the timeline with 
video and audio on the timeline. 

• Rearrange Items On, Slide Track  Use this command to arrange the order 
items appear on the Slide track by moving items up or down in the resulting 
dialog box. 

• Rearrange Items On, HTML Track  Use this command to arrange the order 
items appear on the HTML track by moving items up or down in the resulting 
dialog box. 

• Rearrange Items On, Template Track  Use this command to arrange the 
order items appear on the Template track by moving items up or down in the 
resulting dialog box. 

• Presentation Templates  Use this command to see the available templates 
that you can use in your project. Templates are stored in the Presentation 
Templates folder in the Media tab. 

• Video Transitions  Use this command to see the available video transitions 
that you can add between any combination of video and still images on the 
Video track of the timeline. Transitions are stored in the Video Transitions 
folder in the Media tab. 

• Video Effects  Use this command to see the available video effects that you 
can add to video and still images on the Video track of the timeline. All 
available video effects are stored in the Video Effects folder in the Media 
tab.  

• Add Table Of Contents Entry (Ctrl+K)  Use this command to add a table of 
contents entry at the current position of the playback indicator on the 
timeline. You can then type a name and choose what item the entry is 
associated with. 

• Timeline Snaps  Use this command to change the location of a marker�
called a timeline snap�on the timeline. 

• Add Timeline Snap (Ctrl+Shift+P)  Use this menu command to add timeline 
snaps, which help you synchronize digital media on the timeline. 

• Create Clips  Use this command to separate a selected video file into 
smaller clips through clip detection. 
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• Normalize Timeline Audio  Use this command to have audio on the timeline 
adjusted automatically so it plays back at a uniform level in your 
presentation. 

• Audio Levels  Use this command to display the Audio Levels dialog box, 
which enables you to balance sound levels between audio on the Audio 2 
track and the video sound track on the Audio track. 

• Options  Use this command to display the Options dialog box, which provides 
controls for configuring Producer. 

Clip Menu 

The Clip menu provides commands that let you work with video and audio files in 
your project. Most of the commands on this menu are used when you are editing your 
project. The following commands are on the Clip menu. 

• Add To Timeline (Ctrl+D)  Use this command to add the file selected in the 
Media tab to the timeline. As an alternative to using this command, you can 
also drag files displayed in the Media tab to the timeline. 

• Audio, Mute  Use this command to specify that the selected audio file is not 
heard when the file or presentation is played. 

• Audio, Fade In  Use this command to specify that the selected audio file 
starts to play quietly, and then increases to the final playback level over a 
short amount of time when the audio is played in your presentation. 

• Audio, Fade Out  Use this command to specify that the selected audio starts 
to play at the regular playback level, and then decreases in volume as the 
audio ends playback until the audio cannot be heard. 

• Video, Effects  Use this command to add or remove video effects to selected 
video or image files on the Video track of the timeline. 

• Video, Fade In  Use this command to specify that the selected video fades in 
from black. 

• Video, Fade Out  Use this command to specify that the selected video plays 
back regularly, and then fades to black as the video ends playback. 

• Set Start Trim Point (Ctrl+Shift+I)  Use this command to set the starting 
point, or the trim in point, of a video or audio file on the timeline. 

• Set End Trim Point (Ctrl+Shift+O)  Use this command to set the end point, 
or trim out point, of a video or audio file on the timeline. 

• Clear Trim Points (Ctrl+Shift+Del)  Use this command to remove any trim 
points you have added to audio or video files on the timeline. 

• Duration  Use this command to change the amount of time a slide, still 
image, HTML file, Web link, or presentation template displays in your 
presentation. You can change the duration of files that are added to the 
Slide, HTML, or Template tracks on the timeline. 
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• Split (Ctrl+L)  Use this command to split a selected audio or video file on the 
timeline into two smaller clips. 

• Combine (Ctrl+M)  Use this command to combine a previously split audio or 
video file or to combine two contiguous clips that were created through clip 
detection.  

• Properties  Use this command to view information about a selected item. 
You can view properties for items in the Media tab or on the timeline. 

Play Menu 

The Play menu lets you control playback of individual video or audio files or your 
entire project. The following commands are on the Play menu. 

• Play (Ctrl+P)  Use this command to play the current selection in the monitor 
on the Media tab. What plays depends on the current selection. For 
example, if one video file is selected in the Media tab, that video and its 
associated audio will play in the monitor, as shown in Figure 2-4. 

 
Figure 2-4   Playing a digital media file in the Media tab�s monitor. 

• Play Timeline (Ctrl+W)  Use this command to play the contents of the 
timeline. 

• Rewind (Ctrl+Q)  Use this command to rewind the timeline to the beginning. 
The next time the timeline is played, it will start from the beginning. 

• Back (Ctrl+Shift+B)  Use this command to move back one file or clip on the 
timeline. 

• Previous Frame (Ctrl+B)  Use this command to move to the frame 
immediately before the one currently shown in the monitor. 

• Next Frame (Ctrl+F)  Use this command to move to the frame that is 
immediately after the frame currently shown in the monitor. 

• Forward (Ctrl+Shift+F)  Use this command to move forward one file or clip 
on the timeline. 
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Help Menu 

The Help menu gives you access to the Producer Help and additional information 
about Producer. The following commands appear on the Help menu. 

• Help Topics (F1)   Use this command to open the Help provided with 
Producer. The Help covers all the features in Producer. 

• Producer on the Web  Use this command to see the additional information 
about Producer that appears on the Web. 

• About Microsoft Producer  Use this command to display the name, 
copyright, version number, and product identification for Producer. 

Using the Toolbar 

The toolbar provides an alternate way for you to do many common tasks. Using the 
toolbar rather than the corresponding menu commands may help you work more 
quickly and efficiently. To see what each button does, you can point to a button and a 
ToolTip appears that describes the button�s function. 

Figure 2-5 shows the toolbar in Producer. 

 
Figure 2-5  The toolbar. 

Table 2-1 shows the buttons on the toolbar and their menu equivalents. 

Table 2-1   Toolbar buttons. 

Button Button name Corresponding menu command 

 New On the File menu, click New. 

 Open On the File menu, click Open. 

 Save On the File menu, click Save Project. 

 Cut On the Edit menu, click Cut. 

 Copy On the Edit menu, click Copy. 

 Paste On the Edit menu, click Paste. 

 Delete On the Edit menu, click Delete. 

 Undo On the Edit menu, click Undo. 
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Button Button name Corresponding menu command 

 Redo On the Edit menu, click Redo. 

 Properties On the Clip menu, click Properties. 

 Views On the View menu, click one of the available options. 

 
Capture On the Tools menu, click Capture. 

 
Synchronize On the Tools menu, click Synchronize. 

 
Publish On the File menu, click Publish Presentation. 

Using the Tabs 

Each of the Producer tabs�the Media tab, the Table Of Contents tab, and the Preview 
Presentation tab�let you see your project differently. The tabs provide you with three 
different ways for working with your project. 

The Media Tab 

The Media tab is the default view when you first start Producer. The Media tab lets 
you see all the imported or recorded files that you can work with for your current 
project. This is where you work in when beginning a new project and editing it.  

The Media tab is divided into three different panes: the tree pane, contents pane, 
and monitor. Figure 2-6 shows the different parts of the Media tab. 

 
Figure 2-6   The Media tab. 
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The Tree Pane 

The tree pane displays the different types of digital media files you can work with in 
Producer. When you import or record new content, the file for the recorded content is 
automatically stored in the appropriate folder according to its file type. 

In the tree pane, the top five folders are specific to the current project. They only 
contain files that have been imported or recorded for the current project. Each of 
these folders can contain the file types described in Table 2-2. 

Table 2-2   Project-specific tree pane folders. 

Folder Description 

Video Contains video files with .asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, 
.mpg, .mpv2, .wm, or .wmv file name extensions. 

Audio Contains audio files with .aif, .aifc, .aiff, .asf, .au, .mp2, .mp3, .mpa, 
.snd, .wav, or .wma file name extensions. 

Images Contains still image files with .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, 
.png, .tif, .tiff, or .wmf file name extensions. 

Slides Contains PowerPoint presentations with .ppt or .pps file name 
extensions. This folder also contains PowerPoint slides that were 
saved as a Web page with an .htm file name extension in PowerPoint 
and then imported into Producer. 

HTML Contains HTML files with .htm or .html file name extensions. 

The folders below the top five folders are default folders that always have the same 
contents, regardless of project. These folders, described in Table 2-3, appear by 
default in all Producer projects. 

Table 2-3   Default tree pane folders. 

Folder Description 

Presentation Templates This folder contains templates for use in your 
project. The templates define the layout and view 
for the duration they appear in the timeline and in 
your presentation. 

Video Transitions This folder contains video transitions that you can 
add between two video clips or still images on the 
timeline. 

Video Effects This folder contains different video effects that 
you can add to a video or still image in the 
timeline.  
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The Contents Pane 

The contents pane shows the contents of the folder that is currently selected in the 
tree pane. When a folder is selected, all the files that are stored in that tree pane 
folder appear in this area of the Media tab. The main purpose of the contents pane is 
to let you see all the available files you can use for your project. Because the folders 
are divided by the types of data they contain, you can quickly find the particular file, 
video transition, or video effect that you want to use in your project. 

The Monitor 

The monitor lets you play individual video files, audio files, and transitions from the 
contents pane, and it also displays individual still images, slides, HTML files, video 
effects, and presentation templates. It provides a way for you to see or hear an 
individual file. In the monitor, you can also preview parts of your project.  

Below the monitor is a series of monitor buttons. These buttons function just like the 
buttons on a VCR. They let you navigate through individual files on the timeline or in 
the contents pane, or you can navigate through all of the files on the timeline for your 
current project. 

To preview individual files or all of the timeline contents, you can use the monitor 
buttons as an alternative to the menu commands. Both accomplish the same task. 
However, using the monitor buttons is often quicker than using the menu commands. 
Table 2-4 describes the monitor buttons and their corresponding menu commands.  

Table 2-4   Monitor buttons and their menu command equivalents. 

Button Button name Corresponding menu command 

 Play On the Play menu, click Play. 

 Back On the Play menu, click Back. 

 Previous Frame On the Play menu, click Previous Frame. 

 Next Frame On the Play menu, click Next Frame. 

 Forward On the Play menu, click Forward. 

 
Split On the Clip menu, click Split. 

The Table Of Contents Tab 

While working on your project, you might need to edit the table of contents for the 
final published presentation, as well as the introduction page for your presentation. 
Use the Table Of Contents tab to add, edit, delete, or adjust entries in your table of 
contents. By changing these entries, you can specify how you want your table of 
contents to appear in your presentation. Figure 2-7 shows the Table Of Contents tab. 

In addition to editing your table of contents, you can also make changes to the 
introduction page of your final published presentation. This is the page that is 
displayed before your audience begins to play your presentation. 
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Figure 2-7   The Table Of Contents tab. 

The Preview Presentation Tab 

While working with your project, it is easy to get a sneak preview of what your final 
presentation will look like by using the Preview Presentation tab. This tab lets you see 
your final presentation as it would appear if you published it. Figure 2-8 shows the 
Preview Presentation tab. 

 
Figure 2-8   The Preview Presentation tab. 

Unlike previewing your project in the Media tab, previewing your presentation in the 
Preview Presentation tab lets you see all of the elements in your presentation. 
Because you can see all of the digital media files you have added to the timeline, you 
get a complete idea of how all the different files within your project would play in the 
final, published presentation. 
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Using the Timeline 

The timeline provides the main space for you to work on your projects. It�s the canvas 
for creating your presentation. You can see a chronological listing of all the digital 
media files that have been added to the timeline and how they all work together to 
form the complete presentation. 

The timeline is divided into multiple parts: the timeline toolbar, the timeline display, 
and the timeline tracks. Each part plays a valuable role when working on your project 
in Producer. 

Figure 2-9 shows the different elements of the timeline. 

 
Figure 2-9   The different elements of the timeline. 

The Timeline Tools 

Much like the toolbar in Producer, the timeline tools provide an alternative to using 
the menu commands. Using the tools lets you add timeline snaps, zoom in on the 
timeline, zoom out on the timeline, or rewind and play the timeline. Figure 2-10 
shows the timeline tools in Producer. 

 
Figure 2-10   The timeline tools. 
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Table 2-5 describes the menu equivalent of each tool on the timeline. 

Table 2-5   Timeline tools and corresponding menu commands. 

 Tool Corresponding menu command 

 
Add Timeline Snaps On the Tools menu, click Add Timeline Snap. 

 
Zoom Timeline In On the View menu, click Zoom Timeline In. 

 
Zoom Timeline Out On the View menu, click Zoom Timeline Out. 

 Rewind The Timeline On the Play menu, click Rewind. 

 Play The Timeline On the Play menu, click Play Timeline. 

The Timeline Display 

The timeline display is the key to timing the digital media files that appear on the 
timeline. On the timeline, time is displayed in the form hours:minutes:seconds 
(H:MM:SS) by default. By using the timeline display, you can determine how long a 
file on the timeline will play, or how long your entire presentation will play when 
published. 

If you want to increase the time intervals displayed on the timeline, you can click 
Zoom Timeline Out to see a more general overview of your project. However, if you 
want to see the timeline in more precise time, you can click Zoom Timeline In. 

The Timeline Tracks 

While working on a project in Producer, you will most likely be working with a variety 
of different digital media files. To help keep the files separate from one another, the 
different types of digital media files, video transitions, video effects, and presentation 
templates are displayed on different tracks in the timeline. 

By keeping these elements on the different tracks, you can quickly see what has 
been added to the timeline to see how it fits into the timing and appearance of your 
overall project. The names of the added files appear on the timeline in the individual 
tracks to help you manage what files appear in your project. 

In Producer, the following tracks appear in the timeline. 

• Video Track  Any video files or still images that you add to the timeline are 
displayed on the Video track of the timeline. If you decide to add video 
effects to one or many different files on this track, a small icon of a paint 
bucket appears on the track to indicate that a video effect has been added 
to that file in the timeline.  

In Producer, you can expand the Video track by double-clicking the small 
plus sign or by pressing Ctrl+Shift+V. When you expand the Video track, you 
can then see the Transition and Audio tracks. 
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• Transition Track  If you expand the Video track, you can see the Transition 
track (and the Audio track, discussed next). The Transition track lets you see 
any video transitions that have been added between two video or image files 
on the timeline. When you add a video transition, you can see how long the 
transition will play in your final presentation by looking at the shaded region 
of the Transition track.  

• Audio Track  Like the Transition track, the Audio track can only be seen after 
the Video track has been expanded. This track displays the corresponding 
audio for any video that appears on the Video track. 

• Slide Track  If you have imported any PowerPoint slides into your 
presentation and added them to the timeline, they will appear on the Slide 
track.  

• Audio 2 Track  Within your presentations, chances are you will be working 
with different audio files that can contain music or dialog, such as a 
narration of your presentation. Any added audio files are displayed on the 
Audio 2 track of the timeline.  

• HTML Track  Another way of effectively conveying your message in your 
presentation is by adding HTML files that contain pertinent information 
about the topic to your presentation. When you add any HTML files to the 
timeline, the files are displayed on the HTML track. 

• Template Track  The Template track displays any presentation templates 
that you have added to the timeline. The templates determine the layout of 
your presentation�how different elements of the presentation display in a 
viewer�s Web browser.  
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Chapter 3: Starting a 
New Presentation 

Now that you�re familiar with the Producer interface, you�re ready to create your own 
presentation. The first step is to start Producer and begin your new project. You will see 
a dialog box like the one in Figure 3-1. 

The method you use to begin your project is up to you. When you first start using 
Producer, you might find it helpful to use the New Presentation Wizard because it walks 
you through the process of starting a new presentation step-by-step. However, as you 
become more experienced with Producer, you might want to begin your presentation by 
starting with a new, blank project. 

 
Figure 3-1    The dialog box that appears when you first start Producer. 
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In this chapter, you will first create a new project using the New Presentation Wizard. 
Then later in the chapter, you will see how to build a project from scratch by starting 
with a new blank project. 

Using the New Presentation Wizard 

The New Presentation Wizard helps you start a new presentation by walking you 
through the following steps. By going through the New Presentation Wizard, you can 
quickly create a new project, which you can later publish as a presentation. 

While working in the New Presentation Wizard, you can click Cancel at any time. When 
you click Cancel, the wizard ends and any steps you completed to that point will be 
discarded. 

On the other hand, you may decide that you want to complete a few steps in the wizard 
and then continue creating your project on your own. You can do this by clicking Finish 
at any time in the wizard. If you click Finish, any steps you have completed up to that 
point will be applied to your project. For example, let�s say you completed both the 
Choose A Presentation Scheme page and the Presentation Information page in the New 
Presentation Wizard, and then clicked Finish. In this situation, the presentation 
template you chose would be added to the timeline, and the font and colors would be 
selected for your presentation. You would then need to import digital media files and 
add them to the timeline outside of the wizard in order to continue creating your 
presentation, just as you would if you were starting with a new blank project. 

The New Presentation Wizard proceeds as follows. You can complete each of the 
following steps on the individual pages of the wizard: 

1. Read the introduction page that briefly outlines the steps and pages of the New 
Presentation Wizard. 

2. Choose a presentation template for the presentation you are creating. 

3. Choose a presentation scheme for the presentation. 

4. Enter information about your presentation. 

5. Choose a PowerPoint presentation or individual still images that you want to 
include in your presentation. 

6. Choose existing audio and video files that you want to include in your presentation, 
or capture new content using Producer. 

7. Specify whether you want to synchronize your slides and still images with the 
selected audio and video immediately after completing the wizard. 

8. Complete the wizard so the selected content is imported into the current project 
and added to the timeline. 
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Choosing a Presentation Template 

The Presentation Template page of the New Presentation Wizard lets you choose which 
presentation template you want to apply to the current project. The presentation 
template you choose determines the layout and appearance of the content in your 
presentation, as well as which items are displayed. For example, if you plan on using 
slides and still images for a presentation that contains audio without video, you would 
choose an audio presentation template that displays slides and still images, such as 
one of the following presentation templates that are installed with Producer: 

• Clouds Audio � Fixed Slides and HTML 

• Globe Audio � Resizable Slides and HTML 

• Organizational Audio � Resizable Slides and HTML 

• Standard Audio � Resizable Slides 

Even if you have only completed the audio portion of your presentation, you could 
choose any one of these presentation templates and then import and add HTML files or 
Web links at a later time. 

Many times, your presentations will also contain video with accompanying audio. In these 
instances, you would choose a presentation template that displays slides and still 
images, as well as video (with accompanying audio), such as one of these templates: 

• Clouds Video (240x180) � Fixed Slides and HTML 

• Globe Video (240x180) � Fixed Slides and HTML 

• Organizational Video (240x180) � Resizable Slides and HTML 

• Standard Video (320x240) � Resizable Slides and HTML 

The numbers in parentheses describe the size of the video display area, in pixels, in the 
presentation template. The particular presentation template you choose depends on 
the display size of the video you want to playback in the presentation template.  

All of the templates just described are part of the predefined set of templates that are 
installed with Producer. You can add to this set by creating your own custom templates. 
When you copy the new templates into the default template folder, they will appear in 
the contents pane and you can add them to your project.  

The presentation template you choose is applied for the current project and added to 
the timeline after you click Finish in the New Presentation Wizard. If you later decide 
you want to change the template or use multiple templates in your presentation, you 
can easily do so at any time by adding them to the timeline. 

Understanding Presentation Template Styles 

By using different presentation templates, you can change the look and feel of your 
presentation. When choosing a presentation template, it is helpful to understand the 
basic presentation template styles and what they contain. 
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The following list describes the presentation templates installed with Producer and 
briefly explains the appearance of each style: 

• Standard. The Standard template style contains solid colors without 
background images. This lets you display solid colors in your presentation. For 
example, you could create a color scheme that is compatible with that of your 
organization, logo, or campaign. 

• Clouds. The Clouds template style contains one large background image. 
Audio and video content is displayed on the right side in these templates. If 
slides or HTML are displayed in a presentation with a Cloud template, the 
slides and HTML do not resize, meaning that if the window is resized, the 
slides and HTML remain the same, fixed size. 

• Globe. The Globe template style displays a background image and a header 
image at the top of the page. This presentation template style often contains 
small, tiled images in the presentation background. 

• Organizational. The Organizational template style contains one large 
background image. If slides or HTML are displayed in a presentation with an 
Organizational template, the slides and HTML resize. Therefore, if the window 
is resized, the slides and HTML also resize. 

Step-by-Step: Selecting a Presentation Template 

To choose a presentation template: 

1. Click the name of the template in the Templates list box. 

2. Click Next to proceed to the Choose A Presentation Scheme page. 

Choosing a Presentation Scheme 

The Choose A Presentation Scheme page of the New Presentation Wizard lets you 
choose the font and colors to use in your presentation. By choosing a scheme for your 
presentation, you can select which font, font size, font color, and background colors you 
want to use in your presentation. 

In Producer, you will notice that you can accomplish the same task in different ways. This 
is the case when choosing a presentation scheme. The information that you specify on 
this page of the wizard can also be selected through the Presentation Scheme dialog box. 
Therefore, if you create your presentation through the New Presentation Wizard and then 
later decide you want to change the selected colors or font, you can do so without going 
through the New Presentation Wizard again. 

When choosing a presentation scheme, you can change the appearance and colors for 
the table of contents and the slides area of your final published presentation. Figure  
3-2 shows which parts of your final presentation are affected by the choices you make 
when selecting options for the presentation scheme. 
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Figure 3-2   A published presentation showing the table of contents and slides area. 

Selecting the Font and Colors for the Table of Contents 

The table of contents provides an outline or guide to your presentation. It lets your 
users see a list of topics that are covered in your presentation. The topics are clickable 
links that the audience can use to navigate through your presentation. Therefore, if an 
individual watching your presentation in his or her Web browser wanted to watch a 
specific part of the presentation, he or she could do so by clicking the corresponding 
table of contents entry.  

The fonts that you can select for table of contents entries consist of a list of fonts that 
will display properly in most Web browsers. These are fonts that are common and are 
likely to be installed on your audience�s computers. This is important because your 
audience must have the selected font installed on their computers in order to see the 
font in their Web browsers when they watch your published presentation. In addition to 
specifying the font for the table of contents, you can select the font size (which 
determines how large or small the font will appear in the table of contents area of your 
presentation) and the font color. 

After selecting the font, font size, and font color for entries in the table of contents, you 
will also want to specify a background color for the table of contents. When choosing a 
background color, keep in mind the importance of color and contrast. For example, if 
you selected a lighter font color for the table of contents, you should choose a 
background color that contrasts with the table of contents text color. If you choose two 
colors that are similar and do not provide sufficient contrast, the table of contents 
entries will be difficult to see in your presentation. 

Selecting the Background Color 

The Slides Area Background setting determines which color is displayed in the area 
behind your slides. When choosing this color, consider the color used in your 
PowerPoint slides, as well as the color you selected for the table of contents. This will 
help you choose a background color that is suitable for your presentation. 

When choosing background colors, consider what look you want for your presentation. 
For example, your organization might have a standard set of colors that are used in 
corporate communications or on the company�s Web site. You can choose colors to 
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give your presentations a uniform look and feel or to associate that presentation with 
your company�s colors and logos. 

For example, your organization might use a specific shade of blue. If you know the 
color�s RGB value, which is a standard for specifying colors, you could click the Define 
Custom Color button, type the RGB values in the Red, Green, and Blue boxes of the 
Color dialog box, and then add the color to the list of custom colors. This allows you to 
choose the exact shade or color that is used throughout other corporate 
communications and use it in your presentation. This custom color would be available 
in the current presentation as well as in future presentations. You could select this 
custom color for other parts of your presentation as well, such as the font color or 
background color for the table of contents. 

Differences Between Templates and Schemes 

The presentation scheme determines the font and colors that can be used by the 
presentation template or templates you choose. If you apply one of the Standard 
templates to your presentation, the font, font size, and colors you choose will display in 
your presentation. However, if you apply one of the presentation templates which 
contain background images, such as the Clouds, Globe, or Organizational templates, 
the font and colors that display are determined by the presentation template itself 
rather than by the font and colors you select for the presentation scheme. 

After completing the New Presentation Wizard, you can apply one or more additional 
templates to the timeline. This allows you to switch presentation templates throughout 
the presentation. This feature is helpful because you may want your presentation 
scheme colors and fonts to appear during some parts of your presentation, but not 
during other parts. By switching presentation templates and styles, you can dynamically 
change the appearance of your presentation as your audience watches it in their Web 
browsers.  

Step-by-Step: Selecting a Presentation Scheme 

To choose a presentation scheme: 

1. Select the font name from the Font drop-down list. These fonts are listed 
because they can be viewed in a Web browser, and they are most likely 
already installed on your audience�s computers. 

2. Select the font size from the Font Size list for the table of contents entries 
in your presentation. The font size is specified in points. 

3. Click Font Color to choose a color from the Color dialog box. You can 
instead click Define Custom Color, enter values in the Red, Green, and 
Blue boxes for the color, click Add To Custom Colors, and then click OK to 
choose the new custom color. 

4. Click Background to choose or define a background color. 

5. Click Slides Area Background to choose or define a color for the background. 

6. Click Next to proceed to the Presentation Information page. 
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Entering Information About Your Presentation 

It may be helpful to provide your audience with information prior to them viewing your 
presentation. To effectively communicate the purpose and other pertinent background 
information about your presentation, Producer creates an introduction page. Figure 3-3 
shows an example. 

The introduction page is useful because it can help to set your audience�s expectations 
and to state the goal or purpose for the presentation. For example, if you are creating a 
presentation that discusses quarterly corporate earnings, you could provide this 
information on the introduction page along with information about the presenter. 
Furthermore, you can display an image, such as a corporate logo. 

The presentation information is optional. However, by taking a few minutes to complete 
this page, you can convey important details to your audience that can help to increase 
the overall effectiveness of your presentation. This information displays on the 
introduction page in the viewer�s Web browser while your presentation is loading. By 
clicking Preview in the wizard you can see what the introduction page will look like to 
the viewer. That way, you can make any necessary adjustments before you complete 
the New Presentation Wizard. 

 
Figure 3-3   The introduction page for a published presentation. 

Step-by-Step: Entering Presentation Information 

To specify the information for the introduction page: 

1. In the Title box, type a descriptive title for your presentation. This title 
should describe the main point or purpose of your presentation. Specifying 
a title is not required, but strongly recommended. 

2. In the Presenter (Optional) box, type the presenter (or presenters) name. 

3. In the Introduction Page Image (Optional) box, enter the path and file 
name for the image you want to appear on the introduction page. Or click 
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Browse to find the still image, which can be located on your computer, on 
a shared network location, on a CD, and so on. 

4. In the Description (Optional) box, type a brief description for your 
presentation. This description should briefly describe the presentation or 
provide background information about the presentation. 

5. Click Next to proceed to the Import Slides and Still Images page. 

Using PowerPoint Slides or Still Images 

The Import Slides and Still Images page lets you choose which PowerPoint 
presentations or still images you want to include in your presentation. These are the 
slides and still images that you synchronize with audio and video content. 

You can choose the slides or still images from a variety of locations. The slides, 
PowerPoint presentations, or still images can be located on your local computer, on a 
shared network location, on a CD, or on another type of storage device, such as a 
CompactFlash card for a digital camera. 

The following file types can be imported in this page of the wizard. These file types 
include PowerPoint presentations and still image files with the following file name 
extensions: 

• PowerPoint presentations. .ppt and .pps 

• Still image files. .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, .wmf 

Producer lets you import these file types, as well as a wider variety of other digital 
media file types. A complete list of all supported file types is discussed later in this 
chapter. 

When you are selecting your PowerPoint presentations or still images, you may already 
know the order in which you would like these slides and still images to be added on the 
timeline. If so, you can quickly organize the slides or still images you select in this page 
of the wizard. After completing the New Presentation Wizard, the slides and still images 
are added to the timeline in the order that they appear in the Files box. 

You can save time by arranging the slides and still images in the order that you think 
you want them to appear. If you already know the path and file name of the slides or 
still image you want to add, you can type it in the Path box, and then click Add. To 
change the position of a file in the Files box, simply click the file and use the Move Up 
and Move Down buttons. If you change your mind about including a particular file, you 
can use the Remove button to delete the file from the list. If you decide you want to 
reorder the slides or still images after completing the wizard, you can easily do so at 
any time by rearranging them on the timeline. 
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Step-by-Step: Importing Slides and Still Images 

To add slides and still images to your presentation: 

1. If you know the path and file name of the still image or PowerPoint slide or 
presentation that you want to import, type that location, and then click 
Add. 

2. If you want to locate and select the PowerPoint slide or presentation or still 
images, click Browse, locate the slides and still images you want to import 
into your current presentation, and then click Open. 

3. To select multiple PowerPoint presentations and/or still images, you can 
press the Ctrl key and click multiple still images and PowerPoint 
presentations to include in your Producer presentation. 

4. After selecting multiple files, click Move Up or Move Down to specify the 
order that the slides and still images should be added to the timeline. 

5. To remove an item from the list of files to be imported, click Remove. 

6. Click Next to proceed to the Import or Capture Audio And Video page. 

Choosing Audio and Video for Your Presentation 

If you want to include audio or video content in your presentation, the Import or Capture 
Audio and Video page lets you specify these digital media files. If you included 
PowerPoint slides or still images on the previous page, the audio and video files you 
choose will usually relate to those slides and still images. 

The audio and video you want to use in your presentation may be on your computer 
already. If the audio and video has been saved as digital media files, you can choose 
the files you want to use. Like slides and still images, these files may be located on 
your local computer, on a shared network location, or on a CD. On this page of the 
wizard, you can choose to import audio or video files with the following file name 
extensions: 

• Audio files. .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, .wma 

• Video files. .asf, .avi, .m1v, .mp2, .mpe, .mpeg, .mpg, .mpv2, .wm, .wmv 

If the audio and video content that you want to use for your presentation is not saved to 
your computer, network, or a CD, you can go from this page directly to the Capture 
Wizard in order to capture the video, audio, or still images you want to include in your 
presentation. For example, you may have recorded video with a camcorder, but not yet 
transferred it to your computer and saved it as a video file. In this situation, you can 
start the Capture Wizard to save this recorded video footage to your computer. The 
video, audio, or still images you capture and save are then added to the list of files that 
can be imported on the Import Or Capture Audio And VIdeo page of the wizard.  
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If you plan to narrate slides with video or audio, continue working in the New 
Presentation Wizard. After you complete the wizard, you can start the Capture Wizard 
and narrate the slides.  

Just as you can organize the slides and still images, you can also determine the order 
for the corresponding audio and video you want to synchronize with the slides. 
Therefore, when arranging the list of audio and video files to be imported, make sure 
that the order corresponds roughly to the order of the slides and still images you 
selected. You can then easily synchronize the different elements after completing the 
wizard. 

Step-by-Step: Importing or Capturing Audio and Video 

To add digital media files to your presentation: 

1. If you have recorded audio or video that you want to capture on your 
computer, or if you want to capture live video, audio, or still images, click 
Capture to start the Capture Wizard. 

On the main page of the Capture Wizard, you can choose which type of 
content you want to capture. After you capture the content and save it 
as a file, the Capture Wizard ends, and the video, audio, or still image is 
added to the list of files to be imported in the Import Or Capture Audio 
And Video page of the New Presentation Wizard.  

Still images captured from the Import Or Capture Audio And Video page 
are added to the Video track of the timeline. This means that these images 
show in the video display area of the presentation template, not the slide 
display area. 

2. If you know the path and file name of the audio or video file that you want 
to import, type that location in the Path box, and then click Add. 

3. If you want to locate and select the individual audio or video files, click 
Browse, locate the audio or video file you want to import into your current 
presentation, and then click Open. 

Video and audio content you select will be added to the Video and Audio 2 
tracks, respectively, on the timeline after you have completed the wizard. 
You can later synchronize the slides or still images with the audio and 
video you select on this page of the wizard. 

To select multiple audio and video files, you can press the Ctrl key and 
click each video or audio file that you want to include in your presentation. 
If the files appear contiguously, you can press the Shift key, click the first 
file in the list, and then click the last file in the list while still pressing the 
Shift key. 

4. After selecting multiple files, click Move Up or Move Down to specify the 
order in which the audio and video will be added to the timeline. 

5. To remove an audio or video file from the list of files to be imported select 
the file in the Files box, and then click Remove. 
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6. Click Next. Depending on the content you selected, you will either proceed 
to the Synchronize Presentation page or the Complete Presentation page. 

Synchronizing Slides—Now or Later 

The Synchronize Presentation page lets you determine when you want to synchronize 
your slides. You can choose to synchronize your slides immediately after completing the 
New Presentation Wizard, or you can choose to synchronize your slides at a later time. 

If you have captured live or taped audio and video to synchronize with your slides, and 
imported your slides and digital media files in the correct order, you will probably want 
to synchronize your slides immediately after completing the wizard. In this case, click 
Yes on the Synchronize Presentation page before proceeding. 

There are times when you would not want to synchronize your slides with the audio and 
video content immediately after completing the New Presentation Wizard. For example, 
you might have used the Producer PowerPoint add-in program (which comes with 
Producer) to track slide timings when the original, �live� presentation was recorded. 
Since the slides were already synchronized, you would not need to synchronize them 
again.  

As you work with the New Presentation Wizard, you may notice that this page does not 
appear in the following situations: 

• No slides or still images are selected. 

• No audio or video is selected. 

• No audio, video, slides, or still images are selected. 

If any of these situations are true, you will go directly to the last page of the New 
Presentation Wizard, which lets you complete the wizard. 

Step-by-Step: Choosing When to Perform Synchronization 

To specify whether to synchronize slides immediately or not: 

1. If you want to synchronize your presentation immediately after the files are 
imported and the wizard has completed, click Yes. 

2. If you do not want to synchronize your presentation immediately after the 
files are imported, click No. 

3. Click Next to proceed to the Complete Presentation page. 

Completing the Wizard 

The Complete Presentation page lets you finish the wizard and import the content you 
have selected to the presentation timeline. When you click Finish, any content you have 
selected and any information you have entered is then applied to the current project. 
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The content is then added to the appropriate track on the timeline. This lets you 
immediately begin editing your project. 

If you chose to synchronize your slides with audio and video on the Synchronize Slides 
page of the New Presentation Wizard, the Synchronize Slides dialog box opens after 
you click Finish. 

If you change your mind about the presentation you are creating and decide to start 
over, you can easily do so by clicking Cancel on this page or any other page of the New 
Presentation Wizard. 

Step-by-Step: Completing the Wizard 

To finish creating your presentation: 

• Click Finish to close the wizard and import the files you selected and 
create the presentation project, or click Cancel to end the wizard and 
discard your work. 

After completing the New Presentation Wizard, one of the following will occur, 
depending on the choices you made in the wizard. 

• If you click Finish and you chose to synchronize your presentation 
after completing the New Presentation Wizard, the selected files are 
imported into the current project and added to the timeline. In 
addition, the Synchronize Slides dialog box appears. You can then 
synchronize your slides and still images with the audio and/or video 
files you selected. After synchronizing your presentation, you can then 
preview it using the Preview Presentation tab. 

• If you click Finish and you chose not to synchronize your presentation 
after completing the New Presentation Wizard, the files you selected 
are imported into the current project and added to the appropriate 
tracks on the timeline. The Preview Presentation tab is selected for 
you, and you can then preview your presentation. 

Synchronizing Slides and Still Images 

You may already have many PowerPoint presentations or other types of still images 
that you have created. You may even have video or audio that accompanies these 
slides. You can use the synchronize slides feature in Producer to put these elements 
together. With this feature, you can synchronize your slides so a specific slide, slide 
animation, or still image corresponds to the correct part of your video or audio content. 
In order to do this, each slide or other still image must appear on the Slide track of the 
timeline. For the remainder of this section, the term �slide� will refer to all types of still 
images or slides on the timeline. 

You can synchronize your slides with video or with audio only, depending on the type of 
content you choose, and the goal of your presentation. For instance, you might have a 
video recording of an instructor teaching a class (which naturally includes an audio 
track), or you might have only an audio narration without a video image. Regardless, 
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the process for synchronizing slides is basically the same. The main difference you will 
notice is that a video display appears when you are synchronizing with video. 

Step-by-Step: Synchronizing Slides with Video and Audio 

The following procedure describes the step-by-step process for synchronizing 
slides with video or with audio only. Whether you synchronize your slides after 
completing the New Presentation Wizard or later in the process of creating 
your presentation, the synchronize slides feature functions in the same way. 

1. Open the Synchronize Slides dialog box. There are two ways to do this: 

• In the New Presentation Wizard, click Yes on the Synchronize 
Presentation page, and then click Finish to complete the wizard. The 
Synchronize Slides dialog box automatically opens after the files you 
selected are imported and added to the timeline. 

• On the Tools menu, click Synchronize to open the Synchronize Slides 
dialog box. The Synchronize command is only enabled when you have 
added content to both the Slide track and either the Audio 2 or Video 
track. 

2. If you want to preview the current slide timings with the audio and video 
content, select Preview Slide Timing, and then click the Play button. This 
lets you see the slide timings as they currently appear on the timeline. 

It is a good idea to preview the presentation and observe the current slide 
timings before making any changes, especially if you are unfamiliar with 
the content you are synchronizing. This lets you familiarize yourself with 
the content and see how the slides, still images, video, and audio work 
together. You may discover that you need to click Cancel in the 
Synchronize Slides dialog box so you can rearrange the order of the audio, 
video, slides, or still images you are synchronizing. No changes are made 
to the slide timing when you preview the current slide timing. 

3. To begin synchronizing, select Set Slide Timing, and then click the Play 
button. The video or audio begins to play as the current slide or still image 
is displayed in the Slide window. From this point forward, Producer will 
record your actions in real time, so pay close attention to the progress of 
the presentation. When you want the presentation to move to the next 
slide, click Next Slide to set the slide timing. 

4. If your slide contains slide animations, they are displayed in the Slide 
window. You can then click Next Effect to play the next slide animation or 
effect and to synchronize that animation or effect with the particular part 
of the audio or video. 

Whether slide animations or slide transitions are displayed depends on 
the options that you set in Producer. If the options Disable Slide 
Transitions On Import or Disable Slide Animations On Import are selected 
when the PowerPoint pre sentation is imported into Producer, slide 
animations or slide transitions will not display when you are synchronizing 
slides, when you preview your presentation in Producer, or when the 
published presentation is viewed in a Web browser. Therefore, if those 
options are selected, the entire slide will be displayed in the Slide window 
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rather than a particular slide animation. Furthermore, slide transitions will 
not be displayed in your synchronized presentation. 

5. If necessary, use the controls to navigate through the video or audio file. 
You can use these controls to skip ahead in the presentation, which might 
save time if you have slides that remain static for long periods. You can 
also rewind the presentation, but be careful�once you rewind past slide 
timings you�ve already set, the timing information is lost and you will have 
to redo the synchronization from that point forward. 

6. After you have synchronized your slides and still images with video or 
audio, do one of the following: 

• Click Finish after you have completed synchronizing your presentation. 
The slide timings you set are then shown on the respective tracks on 
the timeline. 

• Click Cancel if you want to discard the slide timings you just set. 

Starting a New, Empty Project 

You can accomplish the same result by creating a presentation from a new blank 
project as you can by using the New Presentation Wizard. After you become familiar 
with working in Producer, you may decide that starting a presentation from a new blank 
project is quicker than working through the New Presentation Wizard. Although the New 
Presentation Wizard takes you through the process step-by-step, you may find that you 
prefer to create your presentation on your own. 

At times, it may be helpful to start a new blank project, especially if you are unfamiliar 
with the slides, audio, video, HTML, or other digital media files you are working with. 
Using a new blank project allows you to import and preview slides, audio, or video 
before beginning to create your presentation. You can also easily edit and rearrange 
content on the timeline before synchronizing your presentation.  

Table 3-1 shows the page of the New Presentation Wizard and the equivalent menu 
command you can select to accomplish the same step if you create your presentation 
starting with a new blank project instead. 

Table 3-1   Project Creation Commands. 

New Presentation Wizard page Producer command 

Welcome To The New Presentation Wizard None 

Presentation Template Choose a presentation template and 
then, on the Clip menu, click Add To 
Timeline. 

Choose A Presentation Scheme On the Edit menu, click Presentation 
Scheme. 
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New Presentation Wizard page    Producer command 

Presentation Information On the Table Of Contents tab, enter 
the information in appropriate boxes in 
the Introduction Page area. 

Import Slides And Still Images On the File menu, click Import. 

Import Or Capture Audio And Video On the File menu, click Import. Or, on 
the Tools menu, click Capture. 

Synchronize Presentation On the Tools menu, click Synchronize. 

Complete Presentation None 

Step-by-Step: Starting a New Project 

The following steps will help you start a new presentation using a new blank 
project: 

1. On the File menu, click New. 

2. Import the individual digital media files you want to use in your 
presentation. 

3. Add existing digital media files to the timeline or capture any new video, 
audio, or still images you want to include in your presentation. 

4. Arrange any slides, still images, audio, video, or HTML content on the 
timeline. 

5. Synchronize your presentation. 

Importing Digital Media Files 

When creating a new presentation, the first step is to import existing digital media files 
into Producer. These digital media files can then be added to the timeline and arranged 
appropriately. 

Producer supports a wide variety of digital media file formats. This helps to ensure that 
a majority of your existing digital media files can be used in your presentation. The 
following is a list of digital media file types and file formats that can be imported into 
Producer and used in your presentations: 

• Audio files. .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, .wma 

• HTML files. .htm, .html 
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• Image files. .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, .wmf 

• PowerPoint files. .pps, .ppt 

• Video files. .asf, .avi, .m1v, .mp2, .mpe, .mpeg, .mpg, .mpv2, .wm, .wmv 

Producer keeps your digital media files organized by storing them in folders according 
to file type. This makes it easy to find your captured or imported video files, audio files, 
PowerPoint presentations, HTML files, and other digital media files when you are 
creating your presentation. These folders appear in the Media tab of Producer.  

When you import a file into Producer, the source file remains unchanged in its original 
location. You can edit the original source file outside of Producer and any changes you 
make to the source file will be reflected in the file shown in your current project. On the 
other hand, any editing you perform in Producer does not change the source file. To 
ensure that Producer can locate all the necessary files for a project, it is strongly 
recommended that you do not rename, move, or delete the original source files. 

Producer lets you set many options to customize Producer for your own use. These 
options relate to different aspects of creating a presentation in Producer. One of these 
customizable aspects involves importing digital media files. The following sections 
discuss the different options associated with importing files into Producer. 

Importing PowerPoint Presentations 

Your PowerPoint presentations may include slide animations and slide transitions. You 
can add these types of effects when creating the original PowerPoint presentation. In 
Producer, you can specify whether you want PowerPoint slide animations or slide 
transitions to be displayed. 

Whether slide animations or transitions are displayed in Producer depends on whether 
the Disable Slide Animations On Import and Disable Slide Transitions On Import check 
boxes on the General tab of the Options dialog box are selected when the PowerPoint 
presentation is imported. This is true whether you import slides by using the Import 
command or the New Presentation Wizard. 

For example, if the Disable Slide Animations On Import check box is selected when you 
import your PowerPoint presentation, slide animations in this presentation will not 
display in Producer or in your final Producer presentation. If you later decide that you 
want the slide animations to display, you need to re-import the PowerPoint presentation 
into Producer after clearing the Disable Slide Animations On Import check box. This is 
true for slide transitions as well. 

You can also choose whether any audio and video that is already added to your 
PowerPoint presentation is separated from the slides when the PowerPoint 
presentation is imported. This option can be set using the Separate Audio And Video 
From Slides On Import check box on the General tab of the Options dialog box. For 
example, you might have already incorporated audio and video into your PowerPoint 
presentation. If so, you may want to separate audio and video when you import the 
PowerPoint presentation into Producer so you can use the audio and video in other 
parts of your presentation. 

By default, when a PowerPoint presentation is imported, slide animations and 
transitions are displayed and audio and video in the PowerPoint presentation is 
separated from the slides. The default settings for importing PowerPoint slides are 
shown in Figure 3-4. 
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Figure 3-4   Settings for importing a PowerPoint presentation. 

Step-by-Step: Setting PowerPoint Import Options 

The following procedure describes the step-by-step process for setting the 
import options for PowerPoint slides. For these settings to take effect, they 
must be configured before the PowerPoint presentation is imported into 
Producer. 

1. On the Tools menu, click Options, and then select the General tab. 

2. In the Microsoft PowerPoint Slides area, do one or more of the following 
based on the settings you want: 

• If you do not want slide transitions to display and play back in 
Producer, select the Disable Slide Transitions On Import check box. 

• If you do not want slide animations to display and play back in 
Producer, select the Disable Slide Animations On Import check box. 

• For example, if you selected this check box, imported the slides, and 
then synchronized your slides to audio and video you imported, the 
entire slide will be displayed at once, rather than each individual slide 
animation. 

• If you want video and audio to be separated from your slides when a 
PowerPoint presentation is imported into Producer, select the 
Separate Audio And Video From Slides On Import check box. When the 
slides are imported, the separated audio and video files are imported 
and added to the Audio and Video folders that display in the Media 
tab in Producer. 
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3. Click OK to close the Options dialog box and save the new settings. 

Importing Audio and Video 

Producer lets you import a variety of audio and video files for use in your presentations. 
When importing video files, you can choose to have the file separated into smaller, more 
manageable clips. For example, if you had a video file that was 30 minutes long, but you 
only wanted to use a three-minute portion of the file, you could select the Create Clips For 
Video Files check box in the Import File dialog box, and then import the selected video 
file. The file would then be broken down into smaller clips, so you could more easily find 
the particular portion of the video that you want to use in your presentation. How the 
video files are separated into smaller clips depends on the type of video file that you 
select.  

Step-by-Step: Importing Digital Media Files into Producer 

The following procedure describes the step-by-step process for importing 
existing digital media files into Producer. You can import files regardless of 
whether you are creating a presentation with a new blank project or you have 
already started a presentation using the New Presentation Wizard and need to 
import additional digital media files. 

1. On the File menu, click Import. 

2. Locate and select the digital media files you want to import. These files 
can include still images, video, audio, HTML files, and PowerPoint 
presentations. 

You can import multiple digital media files at one time. To do this, press 
the Ctrl key, and then click each file you want to import into your current 
project. If multiple files are listed contiguously in the Import File dialog box, 
you can press the Shift key, click the first file you want to import, and then 
click the last file in the list that you want to import. 

3. Do one of the following: 

• Select the Create Clips For Video Files check box if you want any video 
files you select to be separated in to smaller clips using clip detection. 
Remember, the original file is not changed in any way. 

• Clear the Create Clips For Video Files check box if you do not want any 
selected video files to be separated into clips. 

If you later decide that you want the video file to be separated into clips, 
you can do so after the files are imported by choosing the Create Clips 
command from the Tools menu. Likewise, if this check box is selected and 
you later decide you want the clips to appear as one file, you can combine 
the clips.  
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4. Click Open to import the selected digital media files into Producer. 

When the files are imported into Producer, they are automatically added to 
the appropriate folder in the project. For example, still images are added 
and stored in the Images folder, video files are stored in the Video folder, 
and so forth. 

Saving Your Project 

After you start a presentation using the New Presentation Wizard or a new blank 
project, you will want to save the project. A project is made up of all the files you have 
imported and captured in Producer. This includes any audio, video, or still images you 
have imported or captured in Producer, as well as any HTML files or PowerPoint 
presentations you have imported. 

The arrangement of these items on the timeline is also saved in your project. Therefore, 
you can later open the project and then continue editing from where you left off when 
you last saved your project. A Producer project file has an .MSProducer file name 
extension. 

After completing your project, you are then ready to publish the project as a 
presentation. This is the presentation that your audience will watch in their Web 
browsers on their computers. You can publish the presentation to a variety of locations, 
including an internal intranet site, a shared network location, a Web site, an e-service 
provider�s Web site, or a recordable or rewriteable CD.  

Saving Project Archives—Pack And Go 

With time constraints in the working environment, things are always changing. Even 
after you publish the project as a presentation, you might need to make changes later 
on. For example, you might create and publish a presentation containing marketing 
information for a product line that you know you will change several times a year. 

So that you do not have to create the entire presentation again, you might want to pack 
the project, meaning that all the source files and the actual Producer project file are 
stored in one file�a Producer project archive with an .MSProducerZ file name 
extension. This way, when the updated information is available, you can simply insert 
the new information and then publish the presentation again without starting from the 
beginning. 

Packing a project to create a project archive is helpful because it lets you put all the 
necessary source files in one file. When you import source files, such as video, audio, 
still images, and so forth, Producer links to the source files in their original locations. 
Unfortunately, if the original source file is moved, renamed, or deleted, the link in the 
project file is broken�Producer will not be able to locate the files. As you can probably 
see, this could be a problem if you need to move your project from one computer to 
another or if you think you will need to make changes to the project later on. By packing 
your project, you can avoid this potential problem. 
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After you pack a project, you can then open the packed project archive on another 
computer. Copies of all of the associated source files are also unpacked to the folder or 
location you specify, along with the Producer project file. 

This feature can be especially useful for those who spend a lot of time traveling. For 
example, you might start a presentation on a computer in your office, where you import 
files located on your office computer or a network location into your project, but you do 
not have the time to complete the project and publish it in while you are in your office. 
You could take the CD that contains the packed project archive and then unpack it on 
another computer, such as on a laptop computer. This allows you to work on your 
project while you are on the road without having to worry about broken links from 
source files that were originally located on a network or on your office computer. 

Step-by-Step: Packing and Unpacking a Project Archive 

The following procedure describes the step-by-step process for packing a 
Producer project archive. These first steps describe how to create a project 
archive. 

1. On the File menu, click Save Project. If you have not saved the project yet, 
type a project name in the File Name box, and then click Save. 

2. On the File menu, click Pack And Go. 

The About Pack And Go page appears and provides information about 
using Pack And Go to create a project archive. 

3. On the About Pack And Go page, click Continue. 

4. In the Pack Project As dialog box, click the location where you want your 
project archive to be saved. 

When choosing the location for your project archive, choose a location that 
has enough available disk space. Depending on the source files and 
contents of your project, the project archive file can become quite large. 

5. In the File Name box, type a new name for the archive or accept the 
default project archive name (which is the same name as the Producer 
project file). Click Save to create the project archive. 

The time it takes for the project archive to be created depends on the size of the 
project and the source files used in the project. For example, if you have longer 
video or audio files in your project, the time it takes to create the project archive 
will be greater than if you had shorter video and audio files. Furthermore, your 
connection speed to a corporate network can also play a role if some of your 
source files are located on the network. A project archive cannot exceed 2 
gigabytes (GB) in file size. 
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This second set of steps describes how to unpack the project archive. 

1. On the File menu, click Open, and locate the project archive file. Click 
Open. 

The project archive can be saved on a shared network location, on your 
local computer, on a recordable or rewriteable CD, or on a compressed 
media disk. 

2. In the Browse For Folder dialog box, locate the folder to which you want 
your project file and the associated project files to be unpacked, or click 
Make New Folder to create a new folder. Figure 3-5 shows an example of 
selecting a location to unpack a project. 

 

Figure 3-5   Selecting the folder where the project files will be stored. 

3. Click OK to begin unpacking the project archive. 

The time it takes for the project to be unpacked depends, as before, on 
the size of the files in the project. 

The files are unpacked to separate subfolders based on the file types in 
the project. For example, Figure 3-6 shows the resulting project and 
folders created for a sample interview training presentation. 
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Figure 3-6   The folders created for unpacked project files. 
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Chapter 4: Capture 
Video, Audio, and Still 
Images 

Using the Capture Wizard, you can record audio, video, and still images from a variety of 
sources to your computer. This process is often referred to as capturing content. The 
video sources from which you can capture content range from the mouse actions on 
your computer screen to audio and video recorded on tape or captured live in Producer. 

After you connect your video source, such as a video camera, Web camera, or VCR, to a 
capture device on your computer, you are ready to start capturing video, audio, or still 
images to your computer using Producer. When you capture content to your computer, 
the video, audio, and still images are transferred from the specified source and then 
stored as a digital file on your computer. 

The Capture Wizard can be used for the wide variety of video, audio, or still images you 
may want to include in your presentations. The Capture Wizard walks you through the 
step-by-step process of capturing content to your computer for use in a presentation. 
The process the wizard walks you through changes depending on the capture option you 
choose on the first page of the Capture Wizard. 

Before You Begin Capturing Content 

Whether you are using the Capture Wizard to record content live or from a tape, you can 
take certain steps to maximize the quality of content you capture in Microsoft Producer. 
The following tips can also help you work more quickly and efficiently when capturing 
content in Producer. 
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Closing Unused Programs 

Quitting unused programs can help preserve system resources on your computer. 
Capturing video and audio on your computer requires that you have the necessary 
computing power and available system resources. Quitting unused, open programs can 
help free up valuable resources, such as RAM and video memory. 

Furthermore, quitting unused programs that are not part of the video, audio, or still 
images you want to capture can make the content you capture more effective. For 
example, if you are capturing still images or video from your computer screen, your 
audience sees what is on the computer screen. This means that any icons, open 
programs, or even sensitive data on your computer screen could be captured and seen 
in the video or still images. By taking a few seconds to quit any unused programs, you 
can avoid these problems and save yourself a lot of time when you edit the captured 
video and audio. 

Closing Other Video-related Programs 

Many current capture devices come with accompanying software that you can use with 
the capture device. Before starting the Capture Wizard, make sure that these programs 
are closed. This precaution helps to avoid errors within the Capture Wizard. 

Producer cannot capture video and audio if another program is using the device. For 
example, if you have a Web camera and a standalone program that lets you record from 
the Web camera, the program is using the video device even if you are only viewing the 
video and not recording it. Therefore, you cannot use the Web camera to capture video 
in Producer until the standalone program is closed and the device is no longer in use. 
This applies to other capture devices or recording devices, such as a digital or analog 
video camera, microphone, or TV tuner card you may have attached to your computer. 

Preparing the Office 

If you are recording in an office and it is feasible, try to avoid events that could interrupt 
you if you are recording content live into Producer. Place a note on the door informing 
people that you are recording. This may help to avoid interruptions. Other occurrences 
can interrupt your recording, such as a ringing phone or sounds from your computer. 
Avoiding these interruptions or distractions can help you work more quickly, so you can 
avoid unnecessary retakes when you are recording your video and audio into Producer. 

Making Sure Capture Devices Are Working Properly 

As discussed earlier in this book, there are many different devices you can use to 
capture video and audio in Producer. Make sure that these devices are connected and 
working properly before you start capturing video. By ensuring that the capture and 
recording devices, such as a Web camera, analog camera, or DV camera, are working 
properly, you can avoid issues that could arise during the capturing process. 

Checking Network Permissions 

After capturing any video, audio, or still images in Producer, you will be required to save 
the captured digital media file. If you are working on a corporate network and you plan to 
save the captured digital media files on a shared network location, make sure you have 
sufficient network permission to save and view the file from the shared location. 
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A good way to do this is to open My Network Places, add the shared network location, 
and make sure you can open that location and save files to it. This way, when you want 
to save your captured content in one central location, you can then simply save the files 
to that shared network location. Of course, you will probably want to save the files to a 
location on your hard disk as well. Saving files on your local hard disk can prevent 
performance issues that you may encounter when editing the project where the files are 
stored on a shared network location. Network traffic can interfere with performance 
when you are editing a project and later publishing it as a presentation. 

When creating a project in Producer, it is a good idea to keep the Producer project 
(which has an .MSProducer file name extension) and the associated source files in one 
location. This can help you keep your projects better organized. 

Starting the Capture Wizard 

You can begin capturing video, audio, or still images in Producer by first starting the 
Capture Wizard. You can access this wizard in two different places in Producer: through 
the New Presentation Wizard or through the Tools menu. Each way offers its own 
advantages. 

Starting the Capture Wizard through the New 
Presentation Wizard 

The Capture Wizard can be started from within the New Presentation Wizard if you click 
Capture on the Import Or Capture Audio And Video page. This option lets you capture 
new content to your computer while you are creating a new project through the New 
Presentation Wizard. Therefore, if you have existing audio and video files that you want 
to import into the new project but you also want to capture new content, you can do both 
while creating a new presentation through the wizard. 

Figure 4-1 shows the page in the New Presentation Wizard from which you can start the 
Capture Wizard. 
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Figure 4-1   Starting the Capture Wizard in the New Presentation Wizard. 

The main benefit of using the Capture Wizard through the New Presentation Wizard is 
that you can start and create a project by using the New Presentation Wizard, regardless 
of whether the audio, video, and still images are already stored on your computer. As 
mentioned in the previous chapter, when you complete the New Presentation Wizard, all 
the content you capture or select is automatically imported into the current project and 
added to the timeline. You can then immediately start editing the contents on the 
timeline to continue working on your new project. 

This is not true when you start and use the Capture Wizard by clicking Capture on the 
Tools menu. The video you capture is imported into the current project, but it is not 
automatically added to the timeline unless you narrate slides with video or audio. 
Therefore, you must add any other video, audio, or still images to the timeline before you 
can begin using them in your project. 

Starting the Capture Wizard Through the Tools Menu 

The Capture Wizard can also be started by clicking Capture on the Tools menu. This 
launches the same Capture Wizard that is launched through the New Presentation 
Wizard. However, if you choose to create a new project without using the New 
Presentation Wizard, this is the method you must use to capture video, audio, or still 
images to use in your project. As you become more familiar with Producer, you may find 
that you can begin to create a new project more quickly on your own rather than by using 
the New Presentation Wizard. 

Figure 4-2 shows how you can start the Capture Wizard by using the Capture command 
on the Tools menu. 
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Figure 4-2   Starting the Capture Wizard from the Capture command on the Tools menu. 

Starting the Capture Wizard from the Tools menu enables you to capture new content to 
your computer for an existing project. For example, you may be editing a project on the 
timeline and realize that you need to capture additional content to complete the 
presentation. Instead of having to start your project over (which is what you would have 
to do if you wanted to use the New Presentation Wizard), you could start the Capture 
Wizard and then capture the desired content for your project. You would then need to 
add the new content to the timeline. Except for when you narrate slides with video or 
audio, captured content is not automatically added to the timeline as it is when you 
capture audio, video, or still images through the Capture Wizard in the New Presentation 
Wizard. 

Using the Capture Wizard 

The capture option you choose depends on the type of content you want to capture and 
use in your presentation. Your presentations will often contain a variety of recordings. 
The capturing options are based on the different types of presentations you can create 
in Producer and the content you need for each. 

To help you determine which capture option to use, a brief description of the selected 
capture option appears in the Description area on the Capture Video, Audio, Or Still 
Images page of the Capture Wizard. 

Figure 4-3 shows the first page of the Capture Wizard. This page appears whether you 
start the Capture Wizard through the New Presentation Wizard or through the Capture 
command on the Tools menu. 
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Figure 4-3   The first page of the Capture Wizard. 

As you use the different capture options, you will notice that several pages within the 
Capture Wizard are repeated, often with only slight differences. This helps make the 
capturing process simpler because many of the same tasks apply regardless of the 
capture option you choose. This occurs for common tasks you perform when capturing, 
such as choosing your capture settings, choosing capture devices, and capturing the 
actual video and audio to your computer. 

Most likely, you will use the Capture Wizard more than once while creating a 
presentation. For example, you may need to first capture audio and video from a Web 
camera using the Video With Audio option. You may then need to capture still images 
from your computer screen. 

After you save a captured file, you can then capture more content by using the Back 
button on the Capture Wizard to go back to the Capture Video, Audio, Or Still Images 
page and selecting the appropriate capture option. 

On the first page of the Capture Wizard, some capture options may be shaded and 
cannot be selected. This occurs if you do not have the capture device that is necessary 
for that specific type of capture. For example, if you do not have a video recording device 
installed on your computer, the capture options which include video, such as Narrate 
Slides With Video And Audio, Video With Audio, and Still Images From Video are shaded 
and cannot be selected. These options may also appear shaded if you have a capture 
device attached to your computer, but it is not detected by Producer. 
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The following sections include detailed information about the different capture options 
you can choose in the Capture Wizard. These sections are organized by the different 
types of content you can capture. In each of the sections about capture options, you will 
find the following: 

• Information about the capture options. 

• Brief usage scenarios that provide examples of how the captured content could 
be used in different types of presentations. 

• Detailed information about the specific page of the wizard with which audio, 
video, or still images are captured. 

• Step-by-step procedures for using the Capture Wizard to capture the specified 
type of content. 

Narrating Slides with Video and Audio 

Producer lets you narrate your slides with audio and video or with audio only, depending 
on the type of content you want to include in your presentation. When you narrate slides, 
the narration content is separated into clips that correspond to the individual slides. 

To use either the Narrate Slides With Video And Audio or Narrate Slides With Audio 
capture options, you must first import the slides or still images and add them to the 
Slide track on the timeline. 

The video and audio you capture to narrate the slides is synchronized with either the 
entire slide or an individual slide animation or transition that appears within the slide. 
You can synchronize the audio and video with the entire slide�without animations or 
transitions�by clearing the slide animations and transitions check boxes in the General 
tab of the Options dialog box before importing the PowerPoint presentation. 

If you capture video with audio for a narration, your captured file is saved as a Windows 
Media Video (WMV) file with a .wmv file name extension. If you capture audio only for the 
narration, then your captured file is saved as a Windows Media Audio (WMA) file with a 
.wma file name extension. Video clips and their associated audio clips appear on the 
Video and Audio tracks above the corresponding slide or still image on the Slide track. 
Likewise, if you narrate your slides with audio only, the corresponding audio clips appear 
below the slide on the Audio 2 track of the timeline. 

If you later decide that you need to rearrange the order of the slides, audio, or video on 
the timeline, you can quickly determine where you need to move the corresponding 
video, audio, or slides so that all the different elements remain synchronized after they 
are moved. 

Figure 4-4 shows how the audio of a speaker�s voice that is narrating slides is separated 
into pieces of audio that correspond to the slides. 
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Figure 4-4   An audio track used to narrate slides. 

You can capture audio and video content for narration purposes from a variety of 
capture and recording devices, such as a Web camera, analog or DV camera, 
standalone microphone, or VCR. While you are capturing the content, it can be 
synchronized with the slides on the timeline. 

One example of when you might choose this capture option is distance learning, which is 
becoming more prevalent at many universities. Often, the presenter has a set of 
PowerPoint slides that he or she uses to conduct and teach the class. The presenter 
may decide to record video or audio of the presentation. The instructor, or presenter, 
could then quickly create an on-demand presentation of the class and synchronize the 
audio or video with any PowerPoint slides used during the original class. 

Therefore, if any students were absent or unable to attend the class, they could play the 
on-demand presentation of the class they missed. Students who were at the class, but 
wanted to hear the lecture (or parts of the lecture) again could also play back the 
presentation to review the class. 

In addition to distance learning, corporations could create online training courses. The 
process is the same; you could capture video of a training session, and then use the 
video and audio to narrate the slides. This enables employees to watch the online 
training from their desktop computers at any time. 

Step-by-Step: Narrating Slides with Audio and Video 

The following procedure describes the step-by-step process for narrating slides 
with video and audio. 

In the steps below, narrating slides with both video and audio or with audio only 
are explained simultaneously, because they follow the same basic steps in the 
wizard. The only difference is that video is not captured (and, therefore, not 
displayed) if you choose the audio-only option. 

1. Import and add the slides or still images you want to narrate to the Slide 
track on the timeline. 

2. Depending on the capture device you have connected to your computer and 
the content you are capturing with your slides, do one of the following: 

• If you are using a DV camera or analog camera to narrate slides from 
previously taped video and audio, turn on the device and switch the 
camera to the playback mode (usually labeled VCR or VTR). 
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• If you are using a VCR to capture video and audio from tape, make sure 
the VCR is on. 

• If you are using a DV camera, analog camera, or Web camera to 
capture live video or audio, turn on the device and switch the DV or 
analog camera to the correct position to record live video. 

• If you are using a standalone microphone to capture live audio, make 
sure the microphone is connected to your computer. The input jack is 
usually labeled �Microphone� or �Mic.� 

3. On the Tools menu, click Capture. 

4. On the Capture Video, Audio, Or Still Images page of the Capture Wizard, 
choose one of the following capture options, and then click Next: 

• Click Narrate Slides With Video And Audio if you want to narrate your 
slides with both video and audio. 

• Click the Narrate Slides With Audio option if you want to narrate your 
slides with audio only. 

If you are using a DV camera and are narrating slides, the audio is not 
played back on your computer. Therefore, make sure the volume on the 
camera is set high enough that you can hear the audio to properly 
narrate and synchronize the audio with the slides. 

5. If video or audio already appears on the timeline, one of the dialog boxes 
shown in Figures 4-5 and 4-6 appears. Do one of the following: 

• Click Yes if you want to clear the Video track (or Audio EPSrack, if you 
captured audio only). The narration you capture will then be added to 
the appropriate track of the timeline after completing the wizard. 

• Click No if you do not want to clear the Video track (or Audio 2 track). 
The narration will be imported into the project, but it will not be added 
to the timeline. 

• Click Cancel to return to the Capture Video, Audio, Or Still Images page 
of the Capture Wizard. 

 
Figure 4-5   This dialog box appears if video is already on the Video track. 
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Figure 4-6   This dialog box appears if audio is already on the Audio 2 track. 

6. The next page depends on whether you chose to capture video or just 
audio. The two different pages that can appear are as follows. After you 
choose the capture setting, click Next. 

• If you chose to narrate your slides with video and audio, the Capture 
Video And Audio page appears, and you can choose capture settings 
for capturing video with audio. 

You should choose your capture settings based on the type of video you 
are capturing and the connection rate that your audience will most 
likely use to watch your final presentation. For example, if your 
presentation contains a stationary speaker�a �talking head� video, or 
someone standing at a podium�and you plan to use a presentation 
template with a small video display (240x180), you could choose the 
Typical capture setting. 

If you are unsure about the presentation template you will use, choose 
a capture setting that displays the video at a larger display size. If you 
later choose a presentation template that has a smaller display size, 
the video will still display correctly. Guidelines for choosing capture 
settings are discussed later in this chapter. 

• If you chose to narrate your slides with audio only, the Capture Audio page 
appears, and you can choose capture settings for recording audio only. 

Like choosing the capture setting for video, you should choose your 
audio capture settings based on the type of audio you are capturing 
and the connection rate that your audience will most likely use to watch 
your final presentation. 

For example, if your presentation contains a speaker who is talking, 
and you plan to use an audio-only presentation template, you could 
choose the Typical capture setting. This lets you capture audio that is 
well-suited for voice and mixed audio. Again, guidelines for choosing 
capture settings are discussed later in this chapter. 

7. The options available on the Choose Capture Devices page depend on 
whether you chose to narrate slides with video or with audio only. The 
options also depend on the types of capture devices that are connected to 
your computer. 

Whether a separate input source for video can be selected depends on the 
type of video capture device you are using and its software drivers. Details 
about video capture devices and the combination of video and audio 
sources you can select are discussed later in this chapter. Click Next after 
you have selected and configured your capture devices. 
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8. Choose the appropriate options in the Capture Wizard as follows before 
capturing the video or audio to narrate your slides. 

• Select or clear the Show Preview check box. This check box only appears 
if you have chosen to narrate your slides with video and audio. 

To preserve your computer�s system resources when capturing video 
and audio, it is recommended that you clear the Show Preview check 
box. This can help improve the overall quality of the video and audio 
that is captured. Many DV or analog cameras have built-in LCD panels 
and speakers that let you see the video and hear the audio you are 
capturing. You can use the LCD panel and built-in speaker to preview 
the content instead. 

• Select the Mute Speakers check box if you are capturing live video and 
audio. Muting the speakers prevents audio from being played back on 
the speakers, which can distract from the audio you are capturing for 
your narration. 

• Move the Input Level slider up or down to increase or decrease the 
volume of the captured audio. 

When adjusting the Input Level slider, try to avoid reaching the red 
levels while you are recording. You can test the volume by speaking 
into the audio device and seeing how the levels move up or down on 
the Input Level meter. If the meter reaches the red levels when 
recording, the captured audio will be unclear and distorted. Try to avoid 
low volume levels as well (readings on the lower third of the meter) 
because the volume of the captured audio may be too low and difficult 
to hear. 

If you are using a DV camera for capturing, the Input Level slider does 
not appear. 

• Click Previous Slide or Next Slide until the first slide you want to narrate 
appears in the Slide window. 

9. Depending on whether you are capturing live or taped audio and video to 
narrate your slides, do one of the following: 

• If you are capturing taped video or audio, make sure the playback 
device is set to the playback mode (often labeled VTR or VCR on a 
camera), cue the tape to the part you want to capture, and then press 
the play button. 

• If you are using a DV camera connected to an IEEE 1394 port, you can 
use the Digital Video Camera controls to locate the section of video and 
audio on the tape that you want to capture to narrate your slides. When 
you click Capture, the tape plays back automatically. 

• If you are capturing live video, focus the camera on the subject you 
want to capture. 
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10. Click Capture to begin capturing video or audio. 

As you narrate your slides, click Next Slide to go to the next slide on the 
timeline after you have finished narrating the slide currently displayed in 
the Slide window. 

If your slides contain animations, click Next Effect when you have narrated 
the current part of the slide and you want to move to and narrate the 
following animation. 

After you have finished narrating your slides, click Stop. If you are capturing 
taped video or audio from an analog camera or VCR, press the stop button 
on your camera or VCR as well. 

If you are using a DV camera, the tape will stop playing back automatically 
when you press the Stop button in the Capture Wizard. 

11. In the File Name box, type the name for the captured Windows Media file. 
Click Save, and then click Finish. 

The narration will be saved as a WMV file if you captured video, or it will be 
saved as a WMA file if you captured audio only. 

12. After you complete the Capture Wizard, video and audio is separated into 
clips and added to the timeline. The video or audio clips have the same 
names as the slides they narrate. Click Finish to end the Capture Wizard. 

Clips are added to the project as follows: 

• If you narrated slides with video, the captured video file is separated 
into clips and added to the Video track on the timeline. 

• If you narrated slides with audio only, the captured audio file is 
separated into clips on the timeline and added to the Audio 2 track. 

• If you had video and audio content on the timeline before you captured 
the audio or video narration, and you did not choose to clear the 
timeline when prompted by the wizard, the audio and video is imported 
into the current project, but it is not added to the timeline. 

• If you captured video, it is separated into clips that have the same 
names as the slides they narrate, and then stored in the Video folder. 

• If you captured audio only, the audio file is stored in the Audio folder. 
To match the slides with the audio narration, add the audio file to the 
Audio 2 track of the timeline so that it starts at the same point as the 
first slide that was narrated. 
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Capturing Video and Audio 

Choosing the Video With Audio capture option lets you record live or taped video and 
audio to your computer. The video sources you can record from include a Web camera, 
DV camera, analog video camera, or an analog or digital VCR. The video sources you can 
choose depend on the capture devices installed on your computer. 

Choosing the Audio Only capture option lets you record live or taped audio to your 
computer. You can capture from audio-only sources, such as a microphone, or you can 
capture audio from a video source. 

The video you capture is stored on your computer as a WMV file. When you finish the 
Capture Wizard, the saved WMV file is automatically imported into your current project. It 
is stored in the Video folder on the Media tab. 

If you choose Audio Only, the audio you capture is stored on your computer as a WMA 
file. The saved WMA file is automatically imported into your current project. It is stored in 
the Audio folder on the Media tab. 

Step-by-Step: Capturing Video or Audio 

The following procedure describes the step-by-step process for capturing video 
or audio. These two options follow the same basic steps in the wizard. 

1. Depending on the capture device you have connected to your computer and 
the content you are capturing, do one of the following: 

• If you are using a DV camera or analog camera, turn on the device and 
switch the camera to the playback mode (usually labeled VCR or VTR). 

• If you are using a VCR, make sure the VCR is on. 

• If you are using a DV camera, analog camera, or Web camera to 
capture live video or audio, turn on the device and switch the DV and 
analog camera to the correct mode to record live video. 

• If you are using a standalone microphone to capture audio, make sure 
the microphone is plugged into the appropriate line on your computer, 
usually labeled �Microphone� or �Mic.� 

2. Do one of the following to start the Capture Wizard: 

• On the Import or Capture Audio And Video page of the New 
Presentation Wizard, click Capture. 

• On the Tools menu, click Capture. 

3. On the Capture Video, Audio, Or Still Images page of the Capture Wizard, 
choose one of the following capture options, and then click Next: 

• Click Video With Audio if you want to capture video with audio. 
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• Click Audio Only if you want to capture audio only. You can use this 
option to capture only the audio portion of a video source, if necessary. 

4. The next page depends on whether you chose to capture audio and video or 
audio only. The two different pages that can appear are as follows. After you 
choose the capture setting, click Next. 

• If you chose to capture video, the Capture Video And Audio page 
appears, and you can choose capture settings for capturing video with 
audio. You should choose your capture settings based on the type of 
video you are capturing and the connection rate that your audience will 
most likely use to watch your final presentation. 

For example, if your presentation contains high-motion video, you plan 
to use a presentation template with a large video display (480x360), 
and your audience will watch your presentation over a LAN or 
broadband connection, you might click More Choices, and then select 
the Large Video Display (480x360) For Delivery At 300 Kbps capture 
setting. Guidelines for choosing capture settings are discussed later in 
this chapter. 

• If you chose to capture audio only, the Capture Audio page appears, 
and you can choose capture settings for capturing audio only. As with 
video, choose your audio capture settings based on the type of audio 
you are capturing and the connection rate that your audience will most 
likely use to watch your final presentation. 

For example, if you plan to use an audio-only presentation template 
and your audience will most likely watch your final presentation over a 
LAN or broadband connection, you could then click More Choices and 
select the High Quality Audio For Delivery At 128 Kbps capture setting. 
Guidelines for choosing capture settings are discussed later in this 
chapter. 

5. The Choose Capture Devices page depends on whether you chose to 
capture video or audio and the types of capture devices you have 
connected to your computer. 

Whether a separate input source for video can be selected depends on the 
type of video capture device you are using and its software driver. Details 
about video capture devices and the combination of video and audio 
sources you can select are discussed later in this chapter. 

Click Next after you have selected and configured your capture devices. 

6. Choose the appropriate options in the Capture Wizard as follows before 
capturing your audio and video or audio only: 

• To preserve system resources when capturing video and audio, clear 
the Show Preview check box. This can help preserve valuable system 
resources and can help to improve the overall quality of the video and 
audio that is captured. Many DV or analog cameras have built-in LCD 
panels and speakers that you can use to preview the content. 

• Select the Mute Speakers check box if you are capturing live audio. 
Muting the speakers prevents the audio from being played back on 
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your computer�s speakers, which can distract from audio you are 
capturing. 

• Move the Input Level slider up or down to increase or decrease the 
volume of the captured audio. 

When adjusting the Input Level slider, try to minimize the volume 
sensitivity so that the recording levels do not go into the red. You can 
test the volume by speaking into the audio device and seeing how the 
levels move up or down on the Input Level meter. 

If you are using a DV camera for capturing, the Input Level slider does 
not appear. 

• Select the Capture Time Limit check box to set the amount of capturing 
time. After the time limit expires, capturing stops automatically. 

• Select the Create Clips check box if you want your video to be 
separated into clips after you save the WMV file and it is imported into 
the current project. 

7. Depending on whether you are capturing live or taped audio and video, do 
one of the following: 

• If you are capturing taped video or audio, make sure the device is set to 
the playback mode (often labeled VTR or VCR on a camera), cue the 
tape to the part you want to capture, and then press the play button. 

• If you are using a DV camera connected to an IEEE 1394 port, you can 
use the Digital Video Camera controls to locate the section of the video 
and audio that you want to capture. The tape begins playing 
automatically when you click the Capture button. 

• If you are capturing live video or audio, focus the camera on the person 
or thing you want to record. 

• If you are capturing live audio from a standalone microphone, make 
sure the microphone is attached properly. 

8. Click Capture to begin capturing. 

9. After you have finished capturing video or audio, click Stop. If you are 
capturing taped video or audio from an analog camera or VCR, press the 
stop button on your playback device as well. If you are capturing from a DV 
camera, the tape stops playing automatically. 

If you selected the Capture Time Limit check box, capturing stops 
automatically once the time limit has expired. Therefore, you do not need to 
click Stop. However, you can click Stop to end capturing at any time. 

10. In the File Name box, type a name for the captured Windows Media file. 
Click Save, and then click Finish to complete the Capture Wizard. 

The file will be saved as a WMV file if you captured video, or as a WMA file if 
you captured audio only. 
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After you complete the Capture Wizard, the video and audio is imported into 
the current project. If you captured video with audio, the video is stored in 
the Video folder. If you captured audio only, the audio is stored in the Audio 
folder. 

Capturing Still Images from Video 

With taped or live video, you may have some individual shots that illustrate the point or 
message you are trying to convey to your audience. For these shots, you can capture a 
still image from a video source to use in your presentation. You may also find that you 
want to capture still images from your video and narrate them along with your slides. 
The Capture Wizard enables you to capture these still images from a video source. 

Still images are saved as JPEG image files with a .jpg file name extension. Because the 
still images are captured as JPEGs, you can edit them in most image editing programs. 

Step-by-Step: Capturing Still Images 

The following procedure describes the step-by-step process for capturing still 
images from video. 

1. Depending on the capture devices you have connected to your computer 
and the content you are capturing, do one of the following: 

• If you are using a DV camera or analog video camera to capture still 
images from taped video, turn on the device and switch the camera to 
the playback mode (usually labeled VCR or VTR). 

• If you are using a VCR to capture still images from tape, make sure the 
VCR is on. 

• If you are using a DV camera, analog camera, or Web camera to 
capture still images from live video, turn on the device and switch it to 
the correct position to record live video and audio. 

2. Do one of the following to start the Capture Wizard: 

• On the Import Or Capture Audio And Video page of the New 
Presentation Wizard, click Capture. 

• On the Tools menu, click Capture. 

3. On the Capture Video, Audio, Or Still Images page, click Still Images From 
Video, then click Next. 

4. The Choose Capture Devices page appears, and you can select the capture 
device (and the appropriate input source, if available) to use. Click Next 
after you have selected and configured your capture devices. 
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5. Depending on whether you are capturing still images from live or taped 
video, do one of the following: 

• If you are capturing still images from taped video, make sure the 
playback device is set to the correct playback mode (often labeled VTR 
or VCR on a video camera), cue the tape to the part you want to 
capture, and then press the play button. Press the pause button on the 
camera when you see the frame you want to capture as a still image. 

• If you are using a DV camera connected to an IEEE 1394 port, you can 
use the Digital Video Camera controls to locate the frame of the taped 
video that you want to capture, and then click Pause. 

• If you are capturing live video, focus the camera on the subject you 
want to capture in a still image. 

6. Click Browse to select the location to which you want to save your captured 
still image. The path and file name for the saved image is displayed in the 
File Name box. 

The default name for the first image you capture is Picture_0001.jpg and 
the second image you capture is saved as Picture_0002.jpg, and so forth. 
However, you can replace the prefix of the file name, Picture, with any name 
you want to help you find and organize your still images. 

7. For each still image you want to capture, click Capture Image. 

8. Click Finish to complete the Capture Wizard. The captured still images are 
imported into the current project and stored in the Images folder. 

Capturing Images from Your Computer Screen 

Still images you capture from your computer screen are saved as Portable Network 
Graphics (PNG) files with a .png file name extension. PNG files are bit-mapped images 
that are well-suited to display images that have similar blocks of color. This is often the 
case with different parts of the Microsoft Windows operating system, such as dialog 
boxes, title bars, menu bars, and so forth. 

This capture option can be used for software-related presentations ranging from 
software training to marketing a new software application. The following list provides 
some brief examples of how you could use still images captured from your computer 
screen in your presentations. 

• Software training. During software training, the instructor shows different 
features of a program. The training presentation might even contain �tutorials� 
that students can use to learn the program. In your Producer presentation, you 
could include a screen shot of the correct settings in a dialog box for successful 
completion of the task, or some other appropriate user interface item. 

• Marketing new software. Screen shots are often used when new software is 
being sold or marketed. Think about some new software you may have 
purchased or seen advertised on the Web. Many times the packaging or 
advertising has some screen shots to show the user interface. You can use 
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Producer to capture these types of still images to show a new product and the 
basic elements of the user interface. 

• Introducing a new or revised Web site. You can capture screen shots of a Web 
site as it displays in a Web browser. This is useful if you have a new Web site or 
intranet site that you want to introduce to potential users. You can take screen 
shots of the Web site and explain what its features are used for. 

Step-by-Step: Capturing Screen Images 

The following procedure describes the step-by-step process for capturing still 
images from your computer screen. 

1. Do one of the following to start the Capture Wizard: 

• On the Import or Capture Audio and Video page of the New 
Presentation Wizard, click Capture. 

• On the Tools menu, click Capture. 

2. On the Capture Video, Audio, or Still Images page, select Still images from 
screen. Click Next. 

3. Do one of the following in the Capture Wizard: 

• To capture an image of an area of the screen, click Select Region. Your 
cursor changes to look like crosshairs. Use the crosshairs to click and 
drag a box to specify the area of the screen you want to capture. 

• Drag the Capture icon over the area of the screen you want to capture 
as shown in Figure 4-7. You can resize the capture window to adjust 
the area you want to capture. 

 
Figure 4-7   Selecting the Capture icon in the Capture Wizard. 

When you select an area of the screen by using the Capture icon, 
individual elements in the screen are selected in a rectangular box. For 
example, if you wanted to capture an image of a toolbar, drag the icon 
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on the toolbar you want to capture and drop it on the toolbar. If you 
wanted to capture the entire window of a software application, drag the 
icon over the title bar of the application window and drop it. 

• Type the screen coordinates of the area you want to capture. Enter the 
top-left corner coordinates in the Top Left Corner boxes, and then type 
the width and height of the area you want to capture in the Width X 
Height boxes. Click Apply to select the specified are of the screen. 

4. Click Capture Image to capture the selected area of the screen. When you 
click Capture Image, the Capture Wizard dialog box is minimized so it is not 
included in the image. 

5. In the File Name box, type a name for the captured image, and then click 
Save. The captured image is saved as a PNG file and then imported into the 
current project and stored in the Images folder. 

6. You can repeat steps 3 through 6 to capture and save additional images 
from your computer screen. Click Finish to complete the wizard. 

Capturing Video from Your Computer Screen 

Screen capture videos let you show your audience what is occurring on your computer 
screen. This enables you to demonstrate tasks on a computer that would be difficult to 
describe solely with words and text. 

You can use the following types of capture devices to capture the audio: 

• Standalone microphone 

• Web camera with a built-in microphone 

• Analog video camera 

A DV camera cannot be used to capture audio when you are capturing video from your 
computer screen. 

The video screen capture is saved as a WMV file. Like other video you capture in 
Producer, the video screen captures are added to the current project. 

This capture option is often used for software-related presentations ranging from 
training to marketing. The following list provides some brief examples of how you could 
use video screen captures with audio in your presentations. 

Tips for Successful Video Screen Captures 

When capturing video from your computer screen using Producer, keeping a few simple 
guidelines in mind can increase the effectiveness and the quality of the video you 
capture. 
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• Quit unused applications. Each open software application uses system 
resources. Just as when you capture video or audio from a capture device, you 
should close any unnecessary software applications that are not part of your 
video screen capture. 

• Hide bitmap images when possible. Bitmap images, such as images that might 
appear on the desktop, may not appear optimally in a video screen capture. 
This occurs because there is a reduced number of colors that can be captured 
and displayed properly in a video screen capture. You can avoid this issue by 
setting your desktop background to a solid color. 

• Avoid unnecessary mouse movements. Unnecessary or quick mouse 
movements may not be displayed correctly in your video screen capture due to 
the low number of frames per second (fps) that are captured (approximately 5 
to 10 fps; other video is captured at 15 or 30 fps). Objects move more smoothly 
and with greater clarity when video is captured at a higher number of frames 
per second. Therefore, as you move an object during a video screen capture, 
the object may display unevenly if it is moved quickly. When you type or select 
check boxes or option buttons, do these actions slowly to improve the overall 
quality of the video screen capture. 

• Match the video display size with the appropriate presentation template. As 
mentioned earlier in this chapter, you can improve the quality of the video in 
your presentation by applying a presentation template that displays video at the 
size it was captured. This is especially true when working with video screen 
captures. 

Step-by-Step: Capturing Video from Your Computer Screen 

The following procedure describes the step-by-step process for capturing video 
from your computer screen. 

1. Do one of the following to start the Capture Wizard: 

• On the Import Or Capture Audio And Video page of the New 
Presentation Wizard, click Capture. 

• On the Tools menu, click Capture. 

2. On the Capture Video, Audio, Or Still Images page, click Video screen 
capture with audio. Click Next. 

3. On the Choose Capture Devices page, select the audio capture device (and 
input line if necessary) to use for capturing the audio with your video screen 
capture. Drag the Input Level slider up or down to increase or decrease the 
recording volume level. Click Next to continue. 

For example, if you have a microphone attached to your sound card, you 
would select the sound card as the Audio Device and select Microphone as 
the Input Source. 
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Note that audio from a DV camera cannot be used when capturing video 
from your computer screen. Therefore, if you have a DV camera connected 
to your computer, it will not be displayed in the Audio Device box. 

4. In the Capture Wizard dialog box (shown in Figure 4-8), do the following: 

• Select the Minimize While Capturing check box if you want the dialog 
box to minimize to an icon on the taskbar while you are capturing your 
video screen. This prevents the dialog box from appearing in the video 
you capture. 

• Select the Mute Speakers check box if you are capturing audio with 
your screen capture. Muting the speakers prevents audio from being 
played back on the speakers, which can distract from the audio you are 
capturing. 

• Drag the Input Level slider up or down to increase or decrease the 
volume of the captured audio. 

• In the Capture Setting box, select the capture setting that best matches 
the display size of the area of the screen you want to capture and the 
connection rate your audience will most likely use to watch your 
presentation. 

The capture area is shown as a square on you computer screen, and the 
size changes based on the capture setting you select. The area of the 
computer screen is a fixed size based on the capture setting you selected. 
Therefore, the width and height are also size based on the current capture 
setting. 

5. Drag the box so it appears on the area of the screen you want to capture, 
and then click Capture. 

If you selected the Minimize While Capturing check box, the dialog box 
appears as an icon on the taskbar and the rectangle that shows the 
selected area does not appear. If this check box is cleared, the Capture 
Wizard dialog box will appear in your screen capture if it appears in the 
selected area. 
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Figure 4-8   Capturing video from your computer screen. 

6. Perform the actions on your computer that you want to record for your video 
screen capture. If sound capture equipment is available, you can narrate 
the screen capture and your narration is saved as the audio portion of the 
screen capture video file. 

7. After you have completed you screen capture, do one of the following: 

• If you selected the Minimize While Capturing check box, click the Stop 
Capturing icon on the taskbar to stop capturing. 

• If the Minimize While Capturing check box was cleared, click Stop to 
stop capturing. 

8. In the File Name box, type a file name for your video screen capture, and 
then click Save. Click Finish to complete the Capture Wizard. 

The video screen capture is imported into your current project, and it is 
stored in the Video folder for the current project. 

Understanding Capture Settings 

As you proceed through the Capture Wizard, you are prompted to select the capture 
settings for video and audio. This step occurs when you select any one of the following 
capture options on the first page of the Capture Wizard: 

• Narrate Slides With Video And Audio 

• Narrate Slides With Audio 

• Video With Audio 
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• Audio Only 

• Video Screen Capture With Audio 

The quality of the video in your final presentation depends on the quality of the video 
and audio you capture. Because of this, selecting appropriate video and audio capture 
settings is important. The options in Producer affect the following aspects of the video 
and sound you capture: 

• The number of video frames per second. 

• The video bit rate, which is the speed at which the pieces of video, called bits, 
transfer in your video. 

• The quality of the audio. 

• The audio bit rate, which is the speed at which the audio transfers. 

• The quality of the video and audio when the audience plays your final, published 
presentation. 

For example, you can choose to capture video at different bit rates by using different 
capture settings�even though the settings use the same video display size. The number 
of frames per second that are captured at a higher capture setting (such as Medium 
Video Display (320x240) For Local Playback) is greater than the number of frames per 
second that are captured at one of the lower capture settings with the same display size 
(for example, Medium Video Display (320x240) For Delivery At 300 Kbps). 

The higher capture setting (Medium Video Display (320x240) For Local Playback) 
captures 30 fps, whereas the lower capture setting (Medium Video Display (320x240) 
For Delivery At 300 Kbps) only captures 15 fps. In general, as you increase the number 
of frames per second, motion in your video is displayed more smoothly. However, more 
frames per second also increases the size of the video file. Audio quality is greater when 
you use the higher capture setting because the audio bits transfer at a higher rate than 
they do with the lower capture setting. 

The quality of the video and audio in your final published presentation directly depends 
on the quality of the original captured video and audio. As a general rule, it is always 
better to choose a higher capture setting when you capture the original audio and video. 
If you choose to capture at a lower capture setting, and you then publish your final 
presentation at a higher capture setting, the quality of the video and audio in your 
published presentation will not increase. If you then wanted to increase the quality of 
the video and audio in your published presentation, you would have to recapture the 
content at a higher capture setting, add it to the appropriate place on the timeline, and 
then publish your presentation again at a higher capture setting. This is especially 
important to remember if you need to publish your presentation audiences that may 
connect at different rates in order to play back your presentation. 

For all profiles, you will notice that the information in the wizard changes if you choose to 
record video with audio or audio only. For example: 

• Best used for. This information provides examples and suggestions for the type 
of capture that is best-suited for the selected setting. This information includes 
the recommended audience connection rate. 
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• Size. This setting identifies the display size and the number of frames per 
second for the selected video and audio capture setting. This setting is not 
displayed when you choose to capture audio only. 

Considerations for Choosing Capture Settings 

The following are some questions you should consider, along with guidelines to help you 
choose the appropriate capture setting in Producer. 

What Kind of Content Are You Capturing? 

If you are capturing high-motion video, you would probably want to use a capture setting 
that has a higher bit rate, such as one of the profiles that are designed for delivery at 
300 Kbps or for local playback, rather than a capture setting designed for delivery at 
100 Kbps. If you use a lower capture setting, the movement of the objects might appear 
uneven and jerky because there is not enough video information being captured to 
accurately display the rapid movement. In addition, any audio captured with the video 
will sound better if you select the capture setting with a higher bit rate. The display size 
you choose depends on how you want to use the video in your presentation. 

Conversely, if you have video that does contains some movement or variable noises 
such as a recording of person sitting and talking, but you want the video to display at a 
smaller display size, you can probably safely use the Typical capture setting. 

Which Presentation Templates Are Used in Your Presentation? 

Producer includes different templates that provide a variety of display sizes for video in 
your final published presentation. The display size is based on the template or templates 
that are applied to the presentation. Choose a presentation template that has the same 
or similar display size as the captured video, so the video does not appear stretched and 
distorted in the published presentation. 

For example, if you capture video using the Small Video Display (240x180) For Delivery 
At 300 Kbps capture setting, which has a display size of 240 pixels by 180 pixels, and 
you apply a presentation template that displays video at 640 pixels by 480 pixels, the 
video you captured would not be displayed correctly. The descriptions of the 
presentation templates include the size of the video display for the given template. 

What Is the Connection Speed Viewers Will Use? 

The connection speed used by your audience plays an important role in choosing the 
capture settings for your video and audio. If you capture video with a large display size 
and high bit rate, and then publish it at a higher quality setting, your audience will 
experience a long wait while your video and audio downloads. If your presentation is 
streamed and your audience has slower connection rates, the video and audio may be 
interrupted due to buffering. 

 



 

 Chapter 5: Microsoft PowerPoint Presentations in Producer   74 

Chapter 5: Microsoft 
PowerPoint 
Presentations in 
Producer 

An important part of creating rich-media presentations in Producer includes 
incorporating existing PowerPoint presentations into your Producer presentations. This 
lets you use your existing PowerPoint presentations in another way�to synchronize your 
PowerPoint slides with audio, video, HTML files, still images, and presentation templates 
in order to create one dynamic presentation. In other words, Producer is a tool that helps 
you get even more out of your PowerPoint slides. 

Using PowerPoint to Edit Slides in Producer 

As you are working with imported slides in Producer, you may need to edit them for use 
in your presentation. The types of changes you may need to make can range from 
correcting a small typing mistake to adding a whole new slide. You might also need to 
redesign slides to work with the other elements in your presentation. 

If you discover that you need to make changes while you are working with the slides in 
Producer, you can edit your slides by opening them in PowerPoint. You can make any 
necessary changes, and then save your revised slides. When you go back to Producer, 
the edited PowerPoint presentation is automatically re-imported into Producer with the 
changes you made. 
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You can also open and edit a selected slide by using the Edit Slide command on the Edit 
menu in Producer, which is available only when a PowerPoint presentation or individual 
slide is selected. 

Producer lets you open and edit your slides, whether they are saved and imported as a 
PowerPoint presentation with a .ppt file name extension or saved as a Web page with an 
.htm file name extension in PowerPoint. PowerPoint presentations are stored in the 
Slides folder on the Media tab in Producer. Producer retains information about the slides 
so you can edit them in PowerPoint regardless of whether they were saved as a 
PowerPoint presentation or a Web page. 

Producer does not enable you to directly edit a PowerPoint Show with a .pps file name 
extension. If you want to edit a PowerPoint Show in PowerPoint after it has been 
imported into Producer, do the following: 

1. Delete the show from the Producer project. 

2. Change the file�s .pps file name extension to a .ppt file name extension. 

3. Import the PowerPoint presentation again. 

You can then edit the presentation in Producer using PowerPoint. 

Note that performing these steps removes all timing and synchronization between the 
slides and other elements on the timeline. When the slides are imported again, Producer 
will use either the PowerPoint timings (if they have been specified) or the default timing 
for PowerPoint slides. 

When to Edit Slides 

It�s best to edit your slides before adding them to the timeline. If you edit the slides after 
they have been added to the timeline, the types of edits you make determine whether 
the slides are updated on the timeline automatically. 

For example, if you added your slides to the timeline in Producer, and then decided that 
you wanted to change the slide design, you could choose the slide and then click Edit 
Slide on the Edit menu. After you applied the new design for the overall presentation, 
saved your changes in PowerPoint, and then went back to Producer, the slides would be 
re-imported automatically. The revised slides would appear in both the contents pane of 
the Media tab and on the timeline. 

Other changes are not updated on slides that have already been added to the Slide 
track of the timeline. For example, if the slides have associated slide timings when they 
are imported into Producer and you change any slide timings in PowerPoint, the slides in 
the contents pane will contain the new slide timings. However, any slides that have been 
placed on the timeline will not have the new slide timings and will display in your 
presentation for the amount of time specified by the original slide timings. If you want 
the slides to display with the new slide timings, you would have to delete the slides from 
the timeline, and then add the revised slides to the timeline so the new timings would be 
applied to your presentation. 

If you import slides that do not have any slide timings, and then add the slides to the 
timeline, the slides display for the default amount of time specified by the Microsoft  
PowerPoint Slide option on the Timeline tab of the Options dialog box. If you later add 
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timings, the slides in the contents pane of the Media tab will have the new slide timings. 
The slides on the timeline, however, will not have the timings. 

As a general rule, editing your slides before they appear on the timeline can help you 
work more effectively in Producer. This prevents you from redoing work you have already 
done, such as synchronizing slides with audio or video you have already incorporated 
into your presentation. 

Inserting Images in Slides 

Many of your PowerPoint slides will contain images. When working with slides that you 
are going to use in Producer presentations, make sure you insert the image in the slide. 
To insert an image in PowerPoint, on the Insert menu, point to Picture, click From File, 
and then choose the image you want to insert. The dialog box shown in Figure 5-1 
appears. 

In the dialog box shown in Figure 5-1, make sure you select Insert to embed the image in 
the actual PowerPoint slide. If you click Link To File rather than Insert, the image will not 
display in your Producer presentation because the link will be broken. However, if you 
click Insert and embed the image into the slide, the image will be correctly displayed in 
your final Producer presentation. 

 
Figure 5-1   Inserting an image in PowerPoint 2002. 

Editing Imported Slides in PowerPoint 

The following procedure describes the step-by-step process for editing slides that have 
already been imported into Producer. A sample presentation was created using the 
following step-by-step instructions. You can watch this presentation by opening the file 
\Samples\Chapter 10\EditedInterview.htm on the companion CD. 

You can follow the steps below to edit your own PowerPoint slides and Producer project, 
or you can edit the sample project archive that is included on the companion CD. 
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Step-by-Step: Opening the Sample Project Archive 

The following steps explain how to open the sample Producer project archive 
found on the companion CD. You can unpack this project archive to your own 
computer to begin editing the sample project�this is another use for packing a 
Producer project. 

1. Insert the companion CD in the CD-ROM drive of your computer. 

2. In Producer, on the File menu, click Open. 

3. In the Open Project dialog box, select your CD-ROM drive, and then select 
the Producer project archive named Start_int_train.MSProducerZ. Click 
Open. 

The project archive is located in the \StepByStep\Chapter10\ folder on the 
companion CD. 

4. In the Browse For Folder dialog box, select a folder where you want the 
unpacked project to be stored. Click OK to unpack the project archive to the 
selected location. 

This project archive contains the digital media files that have already been 
imported into the current project, as well as a project file you can use. 

Step-by-Step: Editing Imported Slides in PowerPoint 

This procedure describes the steps required for editing slides in PowerPoint that 
have already been imported into a Producer presentation. 

1. On the View menu, click Preview Presentation Tab. Click Play to begin 
playing the presentation so you can see how the slides are displayed. 

To increase system performance and to see more of the presentation 
elements, you can hide the timeline. To hide the timeline, click the Hide 
Timeline button below the timeline. After previewing your presentation, click 
the Show Timeline button to display the timeline again. 

2. On the View menu, click Media Tab. This is the tab you can use to edit 
slides that have been imported into the current project. 

3. In the tree pane, in the Slides folder, select the PowerPoint presentation 
you want to edit. 

If you are editing the sample project, choose the PowerPoint presentation 
Int_train.ppt in the Slides folder. 

4. On the Edit menu, click Edit Slide. PowerPoint automatically starts and the 
presentation you selected to edit opens. 

You can also select the PowerPoint slides you want to edit on the contents 
pane or the timeline. When you click the Edit Slide command with a slide 
that is selected in the contents pane or on the timeline, PowerPoint 
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automatically opens, and the slide you chose to edit is selected. You can 
then edit your slides using PowerPoint. 

5. If you are editing the slides from your own presentation, make the 
necessary edits in PowerPoint. However, if you are editing the PowerPoint 
presentation from the sample project, do the following steps: 

• On the View menu, point to Master, and then click Slide Master. The 
slide master stores information about the colors, fonts, font sizes, and 
the positioning of elements in your slides. 

• On the Format menu, click Slide Design. This lets you change the slide 
design template that is used for your PowerPoint presentation. 

• In the Slide Design task pane, choose a new design for the PowerPoint 
presentation. In the final sample presentation, the design named 
Digital Dots.pot is used. 

• On the Slide Master View toolbar, click Close Master View to see the 
changes that are applied to all the slides. 

• You will notice that the first slide, Train The Interviewer, displays 
incorrectly. This is because this slide is based on the Title Master slide 
rather than the Slide Master itself. To correct the title slide, on the View 
menu, point to Master, and then click Slide Master. Select the Title 
Master slide, shown in Figure 5-2. The Title Master slide is displayed. 

 
Figure 5-2   The selected Title Master for the Digital Dots.pot slide 
design. 

Click Title Area For AutoLayouts, and move the box near the top of the slide. 
You can drag the box with your mouse or press the Up Arrow on the 
keyboard to move the box up. 

• On the Slide Master View toolbar, click Close Master View to see the 
change for the title slide. 

6. On the File menu, click Save to save the changes to the PowerPoint 
presentation. Your changes will appear in the PowerPoint presentation that 
is already imported into Producer. 
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7. Do one of the following to go back to Producer: 

• Hold down the Alt key and press Tab until the Producer icon is selected, 
and then release the Alt key. 

• Click the Producer button on the taskbar. 

The updated PowerPoint presentation is re-imported automatically, and the 
changes you made to your slides appear in the PowerPoint slides in 
Producer. The changes are made to the slides in the contents pane and on 
the timeline. 

As noted earlier in the chapter, if you make changes to the slide timings in 
PowerPoint, the updated slide timings will appear for the slides in the 
contents pane. However, the timings for slides on the timeline will not be 
updated. 

Using the Producer PowerPoint Add-in 

The Producer PowerPoint add-in program is a feature that is added into PowerPoint 
2002 when you install Producer. The add-in can help you quickly synchronize recorded 
video and audio (or audio only) with a slide show or presentation. To use the Producer 
add-in program to record timings during a live presentation, in PowerPoint, on the View 
menu, click Show Slides And Record Timings. The presentation automatically goes into 
the Slide Show view, where slides are displayed full screen and timing begins (see Figure 
5-3). 

For example, you can use a video camera to record video and audio of a speaker giving 
a presentation with a PowerPoint slide show. After the presentation, you can capture the 
video and audio to your computer by using Producer, and then add the PowerPoint 
presentation to the timeline. 

If the speaker used the Producer PowerPoint add-in program when giving the 
presentation, slide timings are recorded with the presentation in PowerPoint. When you 
add the presentation to the timeline, the slide timings are applied, making it easy to 
synchronize the slides with the video track. All you have to do is align the first slide with 
the beginning of the video and the rest of the slides shift to synchronize with the video. 

When the presenter advances to the next slide or animation, PowerPoint automatically 
records the slide timing. The presenter does not need to do anything different from the 
normal process of displaying a slide show. After the presentation is completed and the 
slide show ends, the presenter only needs to save the PowerPoint presentation, and the 
new slide timings will be saved with the PowerPoint slides. 

When you record the video and audio of the presentation, the camera should be focused 
on the presenter rather than on the slides. This lets the online audience see the 
presenter, including all of the gestures he or she makes while discussing the topic at 
hand. You can easily add the slides to the Slide track, just as you would in any other 
presentation created in Producer. 



Using Microsoft Producer: A Guide for Educators 

 Chapter 5: Microsoft PowerPoint Presentations in Producer   80 

 
Figure 5-3   Starting the Microsoft Producer PowerPoint add-in program. 

Working with Slide Timings 

One advantage of the Producer PowerPoint add-in program is that the presenter can 
change to any slide at any time, and the slide timings are recorded to reflect those 
changes. For example, if a presenter is giving a live presentation and he or she is 
speaking about the fifth slide, but someone in the audience asks a question about the 
third slide, the presenter can go back in the slide show to display the third slide. When 
the presenter does this, PowerPoint records slide timings for both the first and second 
times the third slide was shown. When you add the entire presentation to the Slide track 
of the timeline, the third slide is added twice on the Slide track, in the same sequence 
and timing as the live presentation. 

Slide animations are only shown the first time the slide is displayed during the slide 
show. Therefore, when you add the slides to the timeline in Producer, any slide 
animations are only shown the first time the slide appears on the timeline. The second 
time the slide with animations is displayed, the entire slide is displayed without playing 
back the slide animations. If you want the animations to appear the second time the 
slide is shown, you need to delete the second instance of the slide on the timeline and 
then add the original slide from the contents pane to the timeline again. 

If you use the Rehearse Timings feature in PowerPoint to record slide timings and you go 
back and forth during the presentation, PowerPoint only records the last time the slide 
appears for the slide timing. If you use this feature and the presenter goes back and 
forth in the slideshow when giving the live presentation, the slide that was shown 
multiple times would only be added once to the timeline with timings for the last time 
the slide was shown in the presentation. Therefore, if you use Rehearse Timings, you will 
need to rearrange your slides on the timeline in Producer if you want to synchronize the 
slides with the audio and video recorded during the live presentation. 

When working with slides that you have timed with the add-in program and then 
imported into Producer, avoid editing the slides. Because the slide timings are recorded 
and then synchronized with the captured audio and video, any changes you make to the 
slides can disrupt the timing so that the slides are no longer synchronized with the video 
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and audio. For example, if you have a PowerPoint presentation timed with the add-in 
program and the video and audio, but you decide to add a new bulleted item in your 
slide, the timing for the entire presentation could be disrupted. In this situation, you may 
have to resynchronize your slides with the video and audio. 

Understanding Add-in Security Issues 

The Producer PowerPoint add-in program is automatically installed with Producer. 
Therefore, if you can run Producer, the PowerPoint add-in program is already installed on 
your computer. However, to see the Show Slides And Record Timings command on the 
View menu of PowerPoint, which is the command to start and use the add-in program, 
the security settings in PowerPoint must be set to allow the add-in program to run. If you 
do not see this command on the View menu, adjust your security settings to use the add-
in. 

The security settings in PowerPoint appear in the Security dialog box. You need to find 
the right balance when making security level choices, so you can work comfortably with 
PowerPoint while maintaining adequate security. For example, if your PowerPoint 
security settings were set as shown in Figure 5-4, you could use the add-in program as 
well as any other add-ins and installed templates in PowerPoint. 

You could increase your security level by making the security settings for macros more 
restrictive, allowing you to choose on an individual basis which add-in programs (which 
contain macros) you want to allow in PowerPoint. You can change these settings in  
the Security dialog box on the Security Level tab, which you can find by clicking the 
Macro Security button on the Security tab of the Options dialog box. Figure 5-5 shows 
the Security dialog box in relation to the Options dialog box. 

 
Figure 5-4   Security settings to trust all installed add-ins and templates. 
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Figure 5-5   The Security dialog box. 

If the Trust All Installed Add-Ins And Templates check box is not selected, Microsoft 
Corporation is not listed as a trusted source, and the security settings shown in Figure  
5-5 are applied, then a warning dialog box will appear each time you want to use the 
PowerPoint add-in. This warning will ask whether you want to enable the add-in program 
(see Figure 5-6). If this occurs, click Enable Macros to use the Microsoft Producer 
PowerPoint add-in program. 

 
Figure 5-6   Warning message for the Microsoft Producer PowerPoint add-in program. 

Using Slide Animations and Transitions 

You can add animations and transitions to your PowerPoint presentations. Animations 
let you add movement to particular parts of a slide, such as text. A slide transition 
determines how the slides will change from the current slide to the next slide in your 
presentation. 

Not all animations and transitions that you can use in PowerPoint will appear in your 
Producer presentations. Therefore, when creating slides that you plan to use in Producer 
presentations, it is a good idea to periodically preview your slides as a Web page (on the 
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File menu in PowerPoint, click Web Page Preview). If the slide displays correctly in this 
preview, it should display correctly in your final Producer presentation. 

Whether or not slide animations and slide transitions are shown in Microsoft Producer is 
determined when the PowerPoint presentation is imported into the current project. If the 
Disable slide transitions on import or the Disable slide animations on import settings are 
selected, slide transitions and slide animations are not displayed in your presentation. 
Though animations and transitions can add visual interest to your slide show, you can 
improve the playback quality of a Producer presentation by limiting their use. 

In PowerPoint, you add two main types of animations: time-based animations and on-
click animations. The type of animation that is applied to the slide in PowerPoint 
determines how the slide is displayed in your Producer presentation. 

Using Time-Based Animations 

Time-based animations are slide effects such as custom slide animations, which occur 
with or after a specific event in the slide. These types of time-based animations are 
displayed in the Custom Animation task pane in PowerPoint with either a small icon of a 
clock next to the applied animation or no icon at all as shown in Figure 5-7. These 
animations have start values of With Previous or After Previous. Animations that start 
With Previous do not have an icon, whereas animations that start After Previous feature 
the small clock icon. 

 
Figure 5-7   A PowerPoint slide with time-based animations. 

When slides that have time-based animations are used in a Producer presentation, the 
effects are not controlled by Producer. The time-based animations occur according to 
the settings applied in PowerPoint, including the speed at which they play and the 
direction from which they appear, such as From Top, From Bottom, and so forth. 

You can see how these effects are displayed when you add the slides to the timeline and 
then preview the presentation in the Preview Presentation tab. When you are 
synchronizing these types of slides with video or audio, either through the slide narration 
options in the Capture Wizard or the Synchronize Slides dialog box, the animations occur 
automatically. You will be able to see the animations and synchronize the narration or 
other digital media with them appropriately. 
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Using On-Click Animations 

On-click animations are slide effects, such as custom slide animations, that occur after a 
mouse click. Figure 5-8 shows an example of a slide with an on-click animation. These 
types of animations are displayed in the Custom Animation task pane with a small icon 
of a mouse. These animations have the start value of On Click. 

 
Figure 5-8   A PowerPoint slide with on-click animations. 

You can set the timing for slides with on-click slides animations in several ways: 

• Using the Rehearse Timings command on the Slide Show menu in PowerPoint. 

• Using the Record Narration command on the Slide Show menu in PowerPoint. 

• Using the Producer PowerPoint add-in program. 

• Using the Narrate slides with video and audio or Narrate slides with audio 
capturing options in the Capture Wizard in Producer. 

• Using the Synchronize Slides dialog box in Producer. 

On-click animations let you control when the slide animation or slide transition appears. 
Therefore, when you set the slide timings in PowerPoint or Producer, the timings of the 
slide, animations, and transitions are determined by when the presenter clicks the 
mouse to go to the next slide event. 

When a slide with an on-click animation is added to the Slide track of the timeline, the 
slide is displayed with small stars, as shown in Figure 5-9. Each star indicates an 
individual on-click effect and when it appears in the slide. 

If the slide timings for on-click animations are not set in PowerPoint, or if the effects are 
not synchronized with audio or video in Producer, the animations are evenly spaced 
during the duration of the slide when it is added to the Slide track. Furthermore, if a 
slide is trimmed, the slide animations move so they are still evenly spaced during the 
duration of the slide on the timeline. However, the timings of these slide animations are 
not changed if you increase the amount of time the slide displays in your presentation. 
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Figure 5-9   A slide that contains four on-click slide effects. 

After you add slide timings to your PowerPoint slides and import them into your Producer 
project, you should limit the number of changes you make to your slides so that you do 
not need to resynchronize your slides. For example, if you add slide timings and then 
later delete a slide on the timeline that is already synchronized with audio and video, you 
would need to resynchronize your slides with the video and audio so that the changes 
you made are reflected in your final presentation. 

Viewing Slide Animations in Producer 

As mentioned earlier in this book, you can preview your Producer presentations using 
either the Media tab or the Preview Presentation tab. The preview format of your 
presentation and what is displayed in the preview is determined by the tab in which you 
are previewing. Previewing in the Media tab lets you see individual digital media files in 
your presentation, whereas previewing in the Preview Presentation tab lets you see a 
preview of your entire presentation as it will appear when published. When previewing 
slides in Producer, the type of preview is also determined by the tab in which you are 
previewing the slides. Previewing a slide in the Media tab only displays a static image of 
the slide�any added slide effects are not displayed, regardless of whether you are 
previewing the slide from the Slides folder or from the timeline. 

When you play a presentation from the beginning in the Preview Presentation tab, slides 
are displayed dynamically, with slide effects and transitions. If you select an individual 
slide and play it back from the beginning in the Preview Presentation tab, any slide 
transitions and animations are also displayed. Slide animations and transitions are not 
displayed if you start the slide preview when the playback indicator is not positioned at 
the beginning of the slide. 

Moving forward or backward in an individual slide is also possible. In this situation, if you 
skip past a slide effect, the resulting text or object of the effect is still shown in the slide 
and the next slide effect will still be displayed. 
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Video and Audio in PowerPoint Slides 

Your PowerPoint slides may already contain audio and video content. For example, audio 
and video might be embedded in the slide, or a narration might already be added to the 
slide through the Record Narration feature in PowerPoint. If you are creating PowerPoint 
slides that you plan to use in a Producer presentation, you should add the audio and 
video in Producer rather than in PowerPoint. 

When you import slides that contain video and audio, you can choose to have the audio 
and video separated from the slides. You can do this by selecting the Separate Video 
And Audio From Slides On Import check box in the Options dialog box. This lets you add 
the video and audio separately in your presentation, so you can edit it or add it to other 
parts of your presentation. The separated audio and video are imported and added to 
the Audio or Video folders in the project, respectively, with the name of the PowerPoint 
presentation added to the file name. If this check box is not selected, the video and 
audio remain in the slide. 

Other than WAV audio files, any audio and video you insert in your PowerPoint slides are 
inserted as links in your slides. If you choose not to separate the video and audio from 
your slides, the links are maintained in your PowerPoint slides. However, if you publish 
your presentation, these links will not be updated. Therefore, if the audio or video you 
inserted in your PowerPoint slide is only located on your local machine, it will not be 
displayed or played back during the presentation. If you choose to add video and audio 
to your slides using PowerPoint, make sure the audio and video files are linked and 
inserted from a location that your audience has access to, such as a Web site or shared 
network location. 

The easiest way to use audio and video in your PowerPoint slides is to have the audio 
and video separated on import and then to add it to the correct location on the timeline, 
so it plays with the appropriate slide. This ensures that your audio and video will be 
played back correctly in your final published Producer presentation. 

If you choose not to have the audio and video separated from the slides, they will play as 
specified in PowerPoint. If you inserted a video or audio file and specified that you 
wanted it to play automatically in your slides, it will play automatically in your Producer 
presentation when the slide displays. 

When working with video and audio in your slides, be aware of possible issues that can 
arise. For example, if you inserted an audio or video file in your PowerPoint slide, and the 
audio or video plays for one minute, but the slide only displays in your presentation for 
20 seconds, the audio or video will be cut off after 20 seconds. Therefore, if slide 
timings were not already added when you imported the slides, you would need to 
lengthen the duration that the slide appears on the timeline in order to play back the 
entire digital media file. 
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Chapter 6: Publishing 
Your Presentation 

Up to this point, your focus has been on creating the presentation. You�ve arranged your 
digital media on the timeline, and refined the look and feel of your presentation. Now 
you probably can�t wait to show it to someone else. You might have already had a 
colleague or two look over your shoulder and watch your masterpiece in the Preview 
Presentation tab. But how can you show your work to people outside of your school? 

To get your presentation to its intended audience, you use some means of distribution. 
In Producer this is called publishing. Publishing your presentation means making it 
available to your audience, and it involves roughly four steps: 

• Choosing the distribution medium 

• Packaging the contents of your presentation for the selected distribution 
medium 

• Creating the final product 

• Delivering the presentation to your audience 

Producer includes a feature called the Publish Wizard, which makes it easy to package 
your finished presentation and make it available for viewing from a CD, a shared 
network location, a corporate intranet, or the Internet. The Publish Wizard guides you 
through a series of steps in which you provide information about how and where you 
would like to publish your presentation, automatically creates all the files necessary for 
viewing it, and copies each file to the appropriate destination. 

When the publishing process is complete, other people can view your presentation as a 
Web page by using Internet Explorer 5-0 (or later). The Web page that the viewer sees 
contains all the elements you included in your presentation, and the finished product 
looks just like what you saw in the Preview Presentation tab when you were creating the 
presentation. Your audience is not required to have Producer or PowerPoint installed to 
play a published presentation. 
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Understanding the Publishing Process 

Before you jump into publishing your presentation, it is helpful to understand some of 
the concepts you�ll encounter during the publishing process. This includes learning 
about the files published by Producer, information about servers, publishing profiles, 
and e-service providers. 

Files Published by Producer 

When Producer publishes your presentation, it works with data files. There are three 
basic types of files that Producer deals with in the publishing process: 

• Files that you supply. These are files that contain content that you�ve created, 
such as HTML pages or PowerPoint slides. 

• Files that Producer creates from files that you supply. These are Windows Media 
files that Producer encodes by combining the audio and video clips that you 
placed on the timeline. 

• Files that Producer creates from scratch. These are files that Producer 
generates dynamically based on the requirements of your presentation. 

Once Producer assembles all the files necessary to create your presentation, it copies 
them to one or more destinations. Where it copies your files depends upon the 
information you supply in the Publish Wizard. In most cases, Producer copies all the files 
to the same destination folder; in certain cases, Producer copies the digital media files 
to a separate destination folder. The list of files that Producer publishes varies 
depending upon the presentation. You will have an opportunity to view a list of files to be 
published when you use the Publish Wizard. 

Producer Help contains detailed information about the file name extension and purpose 
of each file type used by Producer. 

One very effective way to deliver your presentation to an audience is over a computer 
network, such as the Internet or a corporate intranet. Producer makes it easy to do this 
by handling many of the details for you. In order to make your presentation available for 
delivery over a network, you publish your content to a computer called a server. 

Understanding Servers 

While it is beyond the scope of this book to instruct you in the art and science of server 
administration, there are some things you should know about the servers that host your 
Producer presentations. 

What Is a Server, and Why Do You Need One? 

A server is a computer, connected to a network or the Internet, that stores data that can 
be accessed by other computers on demand. A computer (or the software) that accesses 
data stored on a server is called a client. A Web server is a particular kind of server that 
is specifically designed to deliver content using the standards and protocols of the World 
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Wide Web. The browser software that retrieves and displays a Web page is the Web 
server�s client. 

 

 
Figure 6-1   The client and Web server relationship. 

The terms client and server refer to the relationship between the computers on the 
network. There is no reason a particular computer can�t act as a Web server one 
moment and as a client the next. In fact, a computer can act as both client and server 
simultaneously. 

When you publish your Producer presentation using the My Network Places or Web 
Server options (which will be explained later in this chapter), Producer copies the 
presentation files to the server computer. When someone wants to view the 
presentation, he or she must use Internet Explorer as the client software. The server 
delivers the data that comprises your presentation when the client requests it. 

What Kind of Server Do You Need? 

Producer can publish presentations to Web servers that support the Web-based 
Distributed Authoring and Versioning (WebDAV) protocol, such as Microsoft Internet 
Information Server (IIS). WebDAV is a set of extensions to the HTTP protocol that are 
controlled by the Internet Engineering Task Force (IETF) WebDAV Working Group. In 
order for Producer to publish your presentation directly to a WebDAV server, the server 
location must be configured to allow your computer to read files from it and copy files to 
it. This is called read and write access. You can find out more about WebDAV at the Web 
site http://www.webdav.org. 
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What Is the Difference Between Downloading and Streaming? 

To view your presentation from a network, digital media is delivered over the network to 
client computers. When a server delivers a digital media file to a client computer, it can 
transfer the content in one of two ways: 

• The content can be copied to a new file created on the client. This process is 
called downloading. When enough of the file is copied to the client to 
reasonably assure smooth playback, the player can begin playing the content. 

• The content can display immediately as it is delivered to the client. This process 
is called streaming. In practice, Windows Media Player creates a temporary 
storage area, called a buffer, to hold a portion of the streaming content. When 
enough data has accumulated in the buffer, the player begins to play the 
stream. This allows the player to play back the content smoothly. 

 

Figure 6-2   The client, Web server, and Windows Media server relationship. 

What Is a Windows Media Server? 

A Windows Media server is a computer on which Windows Media Services has been 
installed. Windows Media Services is software that is specifically designed to deliver 
Windows Media content across a network or the Internet. Windows Media Services is 
included with each installation of Microsoft Windows 2000 Server and newer Windows 
server operating systems. 
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You have a choice of using a Windows Media server or a Web server to deliver the 
Windows Media files that are part of your presentation. If you choose to use a Windows 
Media server, it takes on the job of streaming the digital media files, while the Web 
server continues to perform the rest of the functions required to play back the 
presentation. There are several things to consider when deciding whether to use a 
Windows Media server to deliver your Producer Windows Media files: 

• There are important differences between the way a Windows Media server 
delivers digital media and the way a Web server does the job. A Web server 
attempts to deliver the greatest amount of content in the shortest possible 
time. This works great for Web pages, but is not the preferred method for 
streaming digital audio and video. 

• Windows Media server attempts to deliver data in real time, as it is needed. It 
can use feedback from the client to determine network conditions and adjust 
the timing of data delivery to make the most efficient use of the network 
bandwidth. If you expect that viewers will attempt to connect to your 
presentation on a busy network, a Windows Media server can make better use 
of the network resources than a Web server can. 

• If a Web server delivers your presentation to a client computer that has only 
Windows Media Player 6-4 installed, the viewer will have to wait for any 
Windows Media files to finish downloading to the local hard drive before 
watching the presentation. Depending on the length of your presentation, this 
can be very time-consuming. If your Windows Media files are streamed from a 
Windows Media server, the content will begin to play after a short buffering 
delay. In this case, the Windows Media server provides a far better user 
experience. 

• Windows Media servers can use a special communication protocol�the User 
Datagram Protocol (UDP)�to greatly improve streaming performance. UDP 
allows for fast, high-priority data transmission, and uses a more intelligent data-
rate management system than protocols used by Web servers. This means that 
content delivered from a Web server is more likely to be interrupted by periods 
of silence than content streamed from a Windows Media server. 

• Windows Media servers can deliver better audio and video quality than Web 
servers. The constant communication between Windows Media Player and the 
Windows Media server allows the server to continually fine-tune the delivery of 
the streaming content. For example, if the network suddenly becomes 
congested, the Windows Media server might lower the video frame rate in order 
to allow the audio quality to remain high. 

In fact, the only reason not to use a Windows Media server to stream your presentation 
on an intranet or the Internet is that you don�t have access to the Windows Media 
Services software. If your infrastructure simply doesn�t allow you to use a Windows 
Media server, then a Web server will do the job. 

How Do I Publish to a Windows Media Server? 

Publishing using a Windows Media server requires that you supply more information in 
the Publish Wizard than publishing to just a Web server. 

Windows Media Services uses the concept of publishing points. Basically, a publishing 
point is a name that you assign to the location of your content on the server. The client 
uses this name to access the content, rather than the physical location. 
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For detailed information about Windows Media Services, configuring your Windows 
Media server, and using publishing points, see Windows Media Services Help. For a 
complete overview of Windows Media and streaming technologies, see the book Inside 
Windows Media (Que, 1999). 

Selecting a Publishing Profile 

When Producer creates the files for your published presentation, it encodes the content 
you have placed on the timeline into output files. During this process, Producer 
examines each item on the Video, Audio, and Audio 2 tracks to determine its type (audio, 
video, or screen capture). Producer then appropriately combines and compresses the 
content into one or more Windows Media files. There are two main advantages to this 
process. First, combining content makes playback easier since several items of content 
can be streamed from the same file. Second, Windows Media files occupy much less 
space than uncompressed audio and video content on a hard drive. 

A profile is a related group of settings that tell Producer which codec to use to create a 
Windows Media file for your published presentation. (A codec is the software that 
determines how to compress or decompress a Windows Media file.) When you use the 
Publish Wizard to publish your presentation, you choose one or more publishing profiles 
from a list. Producer only includes in this list profiles that are compatible with the 
content on the timeline. The name of each profile in the list describes the intended use 
of the profile. Typically this will include two pieces of information: 

• The type of connection for which the profile is intended, such as local playback 
(playback from the viewer�s computer) or target audience playback (playback 
from a network server or the Internet). 

• The bit rate at which the resulting Windows Media file will play. 

Bit rate refers to the speed at which the Windows Media content transfers between the 
source (which could be a server computer, a CD, or a local hard drive) and the player, in 
this case a Windows Media Player ActiveX control embedded in a Web page created by 
Producer. Bit rate is measured in kilobits per second (Kbps). The bit rate value relates 
directly to the playback quality: the lower the bit rate, the lower the perceived quality; the 
higher the bit rate, the better the perceived quality. 

A typical profile name in Producer might look like this: For Target Audience Playback At 
300 Kbps. 

The Publish Wizard displays a Published Size value for each profile, as well as the total 
size required for all selected profiles, so you can estimate how much hard drive storage 
space your presentation requires. 

You�ll need to decide which profiles to choose, depending on several factors. The 
following sections cover questions you should ask yourself when selecting profiles. Once 
your presentation is published, test the playback using the appropriate connection and 
computer hardware and see what happens. You can always go back and try publishing 
with different profiles until you get the results you want. 
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How Will My Audience View the Presentation? 

You�ll need to know some details about how viewers are connected to the network or the 
Internet, or whether viewers will be downloading the presentation to their local 
computers. The important term here is bandwidth, the capacity of the user�s computer 
and network connection to transfer data. If viewers are receiving your presentation 
through a dial-up connection to the Internet, the bandwidth of the connection will 
typically be low, perhaps up to 56 Kbps. On the other hand, if viewers have a CD that 
contains your presentation, the available bandwidth is restricted only by the internal 
transfer rate of the CD-ROM drive, which is typically very high�much higher, in fact, than 
the highest profile bit rate available in Producer. 

You�ll want to try to match the profile bit rate to the anticipated bit rate at which your 
audience will connect to the presentation. If you can�t make a direct match, you should 
use the next lower profile bit rate. Forcing viewers to stream content at a higher bit rate 
than their connection bandwidth allows will result in a poor playback experience. 

What Playback Quality Does the Presentation Require? 

Remember that the lower the bit rate, the lower the perceived quality during playback. 
You may want to set a minimum connection speed requirement for viewers to help keep 
the quality of your presentation high. 

How Much Storage Space Is Available on the Server? 

As the bit rate and playback quality of a Windows Media file increase, so does the 
amount of hard disk space needed to store the file. You may have storage constraints 
that dictate which and how many profiles you select. 

How Does My Video or Screen Capture Fit into the Presentation 
Template?  

You can choose from a wide variety of interesting presentation templates in Producer, or 
even create your own. You�ll notice when choosing a template that many are designed to 
display at a particular video image size, for example 640x480 pixels. 

When you choose to apply a profile in the Publish Wizard to a presentation that contains 
video or screen captures, the associated bit rate and codec are designed to display at a 
particular image size for optimal viewing. However, when the viewer plays back the 
presentation, the image size will change to match the size specified by the template. 
This means that a low bit rate video, for instance, may not look very good if the image 
expands beyond its intended viewing size. Conversely, shrinking the size of a very high 
bit rate video display might be a waste of bandwidth and storage space since the 
increased quality of the image might not be obvious. 

How Many Different Profiles Should I Use? 

You don�t have to publish using only one profile. How many you choose will depend on 
how you answered the previous questions. If your audience might connect to your 
presentation in more than one manner�both dial-up and corporate network, for 
instance�then you may want to use two profiles. 

On the other hand, each profile adds additional information to the published 
presentation, which takes up additional hard disk space. If you want to publish using five 
different profiles for a variety of bandwidth compatibility options, you might find you 
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don�t have sufficient hard drive space available on the server. Also, keep in mind that 
each additional profile adds to the amount of time it takes to publish your presentation. 
You should start out by publishing with only as many profiles as you require to get the 
job done. 

Publishing with E-services 

In Producer, an e-service is a publishing solution that customizes and simplifies the 
publishing process. Producer exposes an object model to programmers, which they can 
use to change the way the Publish Wizard works. 

When you choose to publish with an e-service, you�ll be presented in the Publish Wizard 
with a custom user interface that was designed by the e-service author. This may look 
and operate very differently from the default Publish Wizard. Typically, an e-service will 
be designed to allow you to choose publishing options (such as profiles or server 
addresses) that are compatible with the hosting services offered by the e-service 
provider. This may hide some of the details of the publishing process from you, making 
the publishing process much simpler and friendlier. 

You can use e-services from several sources, such as: 

• A third-party company that charges a fee for hosting your presentations on its 
Web server. 

• Your company�s own internal e-services, if available. 

• An e-service you design. 

The Producer for PowerPoint 2002 Software Development Kit (SDK) is included with 
each installation of Producer. The SDK contains details about how to create Producer e-
services, including an object model reference, a programming guide, and sample code. 
The Producer SDK can be viewed by double-clicking the file named ProdSDK.chm, which 
is located in the subfolder named Shared where you installed Producer on your hard 
disk.  

Adding an E-service to the Publish Wizard 

To use an e-service, you must first add the e-service to the Publish Wizard. There are 
several ways to do this; you should follow the directions given by the e-service provider. 

Typically, you will navigate through a series of Web pages that display when you click 
Learn More on the first page of the Publish Wizard, or run a file with a .reg file name 
extension, called a registry file. In either case, the e-service details are added to the 
registry on your computer, and the e-service becomes accessible during your next 
Producer session. You may have to close Producer, start a new session, and click OK in 
a dialog box to grant permission to use the new e-service. 

Once an e-service has been added successfully, the e-service name will appear as an 
option in the Web Server list on the first page of the Publish Wizard. When you select the 
e-service in the list and click Next, the e-service�s custom interface appears. Each e-
service is different, so take the time to familiarize yourself with the individual details. 
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Configuring Security Settings for E-services 

Producer allows you to change the default security settings for e-service publishing. 
Producer determines whether you can publish your presentations to an e-service 
provider based on the settings on the Security tab in the Options dialog box. (To display 
the Options dialog box, click Options on the Tools menu.) The e-service options for 
publishing map directly to the security settings for Internet Explorer. 

You can use these settings to prevent an e-service provider from sending or publishing 
files to your local computer, or publishing files to the local intranet or Internet, if the e-
service is not hosted in the specified security zone. For example, to prevent an Internet-
based e-service from publishing files to your local computer, in the drop-down list 
labeled Allow An E-Service To Publish Files To My Local Computer Only If The E-Service Is 
Hosted In The Following Security Zone select My Local Computer, Local Intranet. For 
more information about security settings in Producer, see the Microsoft Producer Help. 

Publishing by using the Web Server option in the Publish Wizard is discussed later in this 
chapter. 

Using the Publish Wizard 

When you click Publish on the Producer toolbar, or choose Publish Presentation from the 
File menu, the Publish Wizard is displayed. The first page of the wizard allows you to 
select one of three choices that represent three types of publishing destinations. 

• My Computer. Select this option if you want to publish your presentation to a 
folder on your local computer or to a recordable or rewritable CD drive. If you 
publish to your hard drive, you�ll be able to watch the presentation on your 
computer in Internet Explorer. If the folder you publish to is shared on a 
network, other users with permission to access the shared folder will be able to 
see your presentation as well. If you publish to a CD, your presentation becomes 
portable and can be viewed on any computer that meets the system 
requirements for presentation playback and also has the appropriate CD drive 
for the recorded media. 

• My Network Places. Select this option if you want to publish your presentation 
to a network location, such as a shared folder on a corporate network server. 
Using this option is identical to publishing using the My Computer option, except 
clicking Browse on the Publishing Destination page opens a file dialog box that 
allows you to browse only network locations. 

• Web server. Select this option if you want to publish your presentation to a 
remote server, such as an Internet site. You should also use this choice if you 
want your Windows Media files to be streamed from Windows Media server, if 
you want to publish to a Web server you have used previously, or if you want to 
publish your presentation using an e-service. 
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Publishing to My Computer 

The easiest way to get a feel for the Publish Wizard is to use it to publish your 
presentation to your hard drive on the same computer you use to run Producer. The 
following steps will guide you through the process: 

1. Start Producer and open your presentation. 

2. Click Publish on the toolbar. The Publish Wizard appears as shown in Figure 6-3. 
Click My Computer. 

Click Next to proceed to the Publishing Destination page, shown in Figure 6-4. 

 

Figure 6-3   The first page of the Publish Wizard. 
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Figure 6-4   The Publishing Destination page. 

3. Type a name for your presentation in the File Name box. The wizard provides the 
project name by default. 

4. In the Publish Files To Box, enter the location of a folder to which Producer can 
publish your presentation. Alternatively, click Browse and use the Browse For Folder 
dialog box to select a folder. Over time, as you use different folder locations, 
Producer will add the paths to the drop-down list so you can easily reuse file paths in 
the future. 

Click Next to proceed to the Presentation Information page, shown in Figure 6-5. If a 
presentation with the same name exists in the publishing folder, Producer will ask 
you for permission to overwrite it. 

5. In the Title box, type a title for your presentation. The title will appear on the 
introduction page and the title bar of the presentation playback window. 

You can also provide the name of the presenter, a path to an image, and a 
description. All this information will be added to the introduction page when the 
presentation is published and will be visible to the viewer. If you have already 
entered the information for your project in the Table Of Contents tab, it will appear 
on this page, and you can skip this step. 

Click Next to proceed to the Playback Quality page, shown in Figure 6-6. 
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Figure 6-5   The Presentation Information page. 

 

 

Figure 6-6   The Playback Quality page. 
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6. Select at least one playback quality profile. The Publish Wizard will offer you only 
profiles that are appropriate for the type of content in your presentation. Since 
you�re publishing to your local computer, make sure only one local playback profile 
is selected for now. 

Click Next to proceed to the Publish Your Presentation page, shown in Figure 6-7. 

 

 

Figure 6-7   The Publish Your Presentation page. 

7. If you�re the curious type, click List Files To Be Published. A separate window opens 
that displays the name of each file that Producer creates and copies to the 
publishing destination folder. It will look something like Figure 6-8, though the file 
names will be different. Click OK when you are ready to continue. 
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Figure 6-8   The listing of files to be published in your presentation. 

8. Read the Publish To path, which is displayed near the bottom of the Publish Your 
Presentation page, and verify that it is correct. If you want to make any changes, 
now is the time to click Back. 

9. Click Finish. You�ll see a dialog box like the one shown in Figure 6-9. The two 
progress bars near the top and middle of the page display the current condition of 
the publishing process, and the Publish Wizard also displays the estimated time 
remaining until completion. 

 

Figure 6-9   Progress is reported as Producer publishes your presentation. 

When the publishing process is complete, the Publish Wizard allows you to preview your 
presentation. Click Yes in the window that asks, �Would you like to view your published 
presentation?� The introduction page for your presentation opens in a separate Internet 



Using Microsoft Producer: A Guide for Educators 

 Chapter 6: Publishing Your Presentation   101 

Explorer window, like that shown in Figure 6-10. Click Play to view your published 
presentation. 

 

 
Figure 6-10   The presentation�s introduction page displayed in Internet Explorer. 

When you�ve finished watching your masterpiece, close the Internet Explorer window. 
Click Close to exit the Publish Wizard. 

Congratulations! You�ve published your first Producer presentation. You can view the 
presentation again at any time. Simply use Windows Explorer to browse to the folder you 
specified in the Publish Files To Box in the Publish Wizard, and then locate the HTML file 
that has the name you provided in the File Name box. Double-click the file to open it, 
and your introduction page will appear in the browser window. 

Publishing to a CD 

Publishing your Producer presentation to a recordable CD has several advantages. First, 
the presentation can be viewed on a computer that isn�t connected to a network or the 
Internet. As long as the computer meets the minimum system requirements for playback 
and has a CD drive capable of reading the CD, the presentation will play. 

Second, you can publish multiple presentations on the same CD. This is useful if, for 
instance, you have a series of lectures you�d like to offer as a package. You can also 
hand out your CDs at a trade show, sell them through the mail or at a retail store, or 
provide them as classroom materials. 

If you are using the Windows XP operating system and have a recordable or rewritable 
CD drive, the Publish Wizard makes publishing to a CD easy. You can follow these steps 
to make a Producer presentation CD: 

1. Start Producer and open your presentation. 

2. Click Publish on the toolbar. The Publish Wizard appears. If it isn�t already selected, 
click My Computer. 
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Click Next to proceed to the Publishing Destination page. 

 

Figure 6-11   Specifying the location of a recordable CD drive. 

3. Type a name for your presentation in the File Name box. The wizard provides the 
project name by default. 

4. In the Publish Files To box, type the drive letter that corresponds to your recordable 
CD drive, such as G:\, as shown in Figure 6-11. Alternatively, click Browse and use 
the Browse For Folder dialog box to select the drive. 

Click Next to proceed to the Presentation Information page. 

5. In the Title box, type a title for your presentation. 

Optionally, provide the name of the presenter, a path to an image, and a description. 
All these will be added to the introduction page when the presentation is published 
and will be visible to the viewer. 

Click Next to proceed to the Playback Quality page. 
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Figure 6-12   Selecting a local playback profile. 

6. Select at least one playback quality profile, as shown in Figure 6-12. The Publish 
Wizard will offer you only profiles that are appropriate for the type of content in your 
presentation. For now, since you�re publishing to a CD, select a local playback 
profile to get the best quality. 

Click Next to proceed to the Publish Your Presentation page. 

7. Click List Files To Be Published if you want to see the file name of each file that 
Producer creates and copies to the publishing destination folder. Click OK to 
continue. 

8. Read the Publish To path, which is displayed near the bottom of the Publish Your 
Presentation page, and verify that it displays the drive letter specifier of your 
recordable CD drive. 

9. Click Finish. The two progress bars near the top and middle of the page display the 
current condition of the publishing process, and the Publish Wizard also displays the 
estimated time remaining until completion. 

10. When the publishing process is complete, the Windows XP CD Writing Wizard 
appears automatically, as shown in Figure 6-13. Type the name you want to give to 
the CD. The wizard offers the current date as the default name. 
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Figure 6-13   Creating a presentation CD in Windows XP. 

11. Insert a recordable CD in the drive you specified in the Publish Wizard. Click Next to 
write the files to the CD. The operation progress will be shown in a dialog box like 
the one in Figure 6-14. 

 

Figure 6-14   Writing files to the CD. 

12. When the CD writing completes, click Finish to exit the CD Writing Wizard. Click 
Close to exit the Publish Wizard. 

You can repeat this process as many times as you like using the same recordable CD, as 
long as there is sufficient space on the disc to contain your next presentation. If you 
choose to do this, you should be certain to give each presentation a unique title in the 
Title box in the Publish Wizard. 

When the viewer places a CD containing one presentation into a CD drive, the 
presentation automatically displays the introduction page. When the viewer places a CD 
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containing more than one presentation into a CD drive, Windows automatically opens a 
Web page titled Select A Presentation, which acts as a main menu for the Producer 
content on the disc. Here, the viewer will see a list of all the presentations available on 
the CD. Each title appears as a link, which the viewer can click to open the introduction 
page for that presentation in a separate Internet Explorer window. 

 

Figure 6-15   The Select A Presentation page. 

It�s worth noting that the Windows CD AutoPlay feature can be disabled by the user, and 
the details of how to enable or disable this feature vary depending on the version of the 
operating system. When Producer creates a CD, it includes in the root directory a file 
named autorun.inf, which is a text file that Windows reads to determine what to do when 
a CD is inserted into the drive. The autorun.inf file that Producer includes on a CD points 
Windows to the file named scan.hta, which is the HTML application file that displays the 
Select A Presentation Web page. This means that the Producer presentation CD can be 
run manually by double clicking the scan.hta file in Windows Explorer, or by clicking Run 
on the Start menu and typing the path and file name�for example, E:\scan.hta. You 
might want to tell users of your CD about this alternate way to start your Producer 
presentations, just in case the AutoPlay feature is not enabled on the user�s computer. 

Creating a Presentation CD Without Using the Publish Wizard 

It is possible to copy your presentations to a CD manually. You might want to do this if 
you are using an operating system other than Windows XP, or if you want to change the 
published files before creating the CD. The following steps describe the process: 

1. Create one temporary folder on your local computer to contain all the presentations 
you�d like to copy to the CD. 

2. Publish each presentation to the temporary folder using the My Computer option. 

3. Use your favorite CD writing software to copy all the files and subfolders from your 
temporary folder to the CD. Be certain not to copy the temporary folder itself, 
otherwise AutoPlay will not work and viewers will have to open the folder manually to 
view the presentations. 
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Publishing to My Network Places 

Publishing to a folder on your corporate network is a great way to make your 
presentation available to a large audience. This is especially useful for corporate training 
seminars, meetings, and any other presentation that should reach a specific audience. 
The following steps will guide you through using the Publish Wizard to publish your 
presentation to a network folder: 

1. Start Producer and open your presentation. 

2. Click Publish on the toolbar. The Publish Wizard appears. If it isn�t already selected, 
click My Network Places as shown in Figure 6-16. Click Next to proceed to the 
Publishing Destination page. 

 

Figure 6-16   Using the My Network Places option. 
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Figure 6-17   Publishing files to a network location. 

3. Type a name for your presentation in the File name box. The wizard provides the 
project name by default. 

4. In the Publish Files To Box, type a path to a shared network folder to which Producer 
can publish your presentation. An example is shown in Figure 6-17. Alternatively, 
click Browse and use the Browse For Folder dialog box to select a folder. 

5. Click Next to proceed to the Presentation Information page. The Publish Wizard will 
prompt you for permission to overwrite a presentation with the same name, if one 
exists. If the Publish Wizard cannot find the network path you specified, a warning 
message displays and you cannot proceed. 

6. In the Title box, type a title for your presentation. 

Optionally, provide the name of the presenter, a path to an image, and a description. 
All these will be added to the introduction page when the presentation is published 
and will be visible to the viewer. 

Click Next to proceed to the Playback Quality page. 
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Figure 6-18   Selecting a profile for network playback. 

7. Select at least one playback quality profile. The Publish Wizard will offer you only 
profiles that are appropriate for the type of content in your presentation. Since 
you�re publishing to a network, click a profile that uses a medium bit rate, such as 
For Target Audience Playback At 100Kbps. Figure 6-18 shows an example. 

Click Next to proceed to the Publish Your Presentation page. 

8. If you want, click List Files To Be Published. A separate window opens that displays 
the file name of each file that Producer creates and copies to the publishing 
destination folder. Click OK to continue. 

9. Read the Publish To path, which is displayed near the bottom of the Publish Your 
Presentation page, and verify that it is correct. 

10. Click Finish. The two progress bars near the top and middle of the page display the 
current condition of the publishing process, and the Publish Wizard also displays the 
estimated time remaining until completion. 

11. When the publishing process is complete, the Publish Wizard allows you to preview 
your presentation. Click Yes in the window that asks, �Would you like to view your 
published presentation?� Be sure to pay attention to the speed at which the 
presentation loads and plays from this point on, since you might want to make 
changes based on the performance you observe. 
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12. The introduction page for your presentation will open in a separate Internet Explorer 
window. 

Click Play to view your published presentation. When you�ve finished watching your 
masterpiece, close the Internet Explorer window. 

13. Click Close to exit the Publish Wizard. 

As you can see, the process in the Publish Wizard to publish your presentation to a 
network location is exactly like publishing to My Computer. If you select the My Network 
Places option on the first page of the wizard, all the subsequent pages will look just like 
what you�ve seen before when publishing to your local hard drive. There are, however, a 
number of considerations you should be aware of when publishing to a network: 

• The network folder to which you publish must have sharing or Web sharing 
enabled. 

• You must have read and write access permissions for the shared folder in 
order to publish. You may need to contact your network administrator to 
request these permissions. 

• The viewer must have read access permission for the shared folder that 
contains the presentation files. 

• If you�ve never worked with network file paths, you�ll have to learn to use 
the Universal Naming Convention (UNC). This means that the path you�ll 
provide in the Publish Files To box in the Publish Wizard will take the form 
of \\YourServerName\YourSharedFolderName\YourPath. If you�re working 
with a remote server, you may need your network administrator to provide 
you with the correct path to your publishing folder. Of course, you can also 
click Browse on the Publishing Destination page of the Publish Wizard and 
use the Browse For Folder dialog box to browse to the correct folder. 

• All your presentation files will be copied to the shared folder, which means 
that anyone with read access permission will be able to examine or copy 
the individual files, and anyone with write access permission will be able to 
alter or delete them. 

• When people play your presentation from a shared network folder, any 
associated files are downloaded to a folder on their computers. This 
includes Windows Media files, which can be quite large depending on the 
length of your presentation and the playback quality profile you selected 
when you published the presentation. If the presentation is large, you may 
want to tell your audience about the possibility of a delay when you send 
them the link to the presentation. 

The Web page that plays your presentation will begin playback when a sufficient portion 
of the Windows Media files has been downloaded. On a congested or slower network 
this might result in a noticeable delay to the viewer, so you should carefully test your 
presentation after you publish it. If necessary, use lower bit rate playback quality 
profiles. You might also want to consider setting up a Windows Media server so your 
Windows Media content can be streamed instead of downloaded. 



Using Microsoft Producer: A Guide for Educators 

 Chapter 6: Publishing Your Presentation   110 

Publishing to a Web Server 

The Web Server option offers the maximum flexibility and control over the Producer 
publishing process. This option allows you to publish your presentation Web files and 
Windows Media files to separate locations, which is important if you want to publish to a 
Windows Media server. You will also use the Web Server option if you choose to use an 
e-service for your publishing needs. 

You can specify a discussion server address to enable viewers of your presentation to 
ask questions or provide comments. You can also provide user name and password 
information for logging into a secure server. 

You can choose the Web Server option in the Publish Wizard to accomplish any of the 
following tasks: 

• Adding a new Web server 

• Using an existing Web server 

• Editing a Web server 

• Deleting a Web server 

• Learning more about publishing 

The following sections describe these options. 

Adding a New Web Server 

You can provide the details about the server to which you want to publish, and give a 
friendly name to that server. The friendly name is added to the Web Server drop-down 
list in the Publish Wizard, and the publishing details are saved. When you want to 
publish to the server in the future, you don�t have to type all the information into the 
Publish Wizard again. 

The following steps will guide you through the process of adding a new Web server in the 
Producer Publish Wizard: 

1. Start Producer and open your presentation. 

2. Click Publish on the toolbar. The Publish Wizard appears. If it isn�t already selected, 
click Web Server. 

3. In the Web Server drop-down list, choose Add a new Web server. Click Next to 
proceed to the Internet Or Intranet Host Settings page, which is shown in Figure  
6-19. 
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Figure 6-19   The Internet Or Intranet Host Settings page. 

4. In the Friendly Host Name box, type the name you want to give this Web server. 
Make it something descriptive so you can remember the purpose of this server. 
Also, make sure you use a unique name for each Web server. For example, you 
might call this server Marketing Department Meetings, or something equally 
descriptive. 

5. In the Publish Web Files To box, type the URL or UNC address of the server to which 
you want to publish your presentation Web files, for example: 

http://yourserver/yourpath 

Optionally, type a URL in the Playback Presentation Address (Optional) box, if the 
URL used to view the presentation differs from the one you typed in the Publish Web 
Files To box. The presentation address is the address that Producer will use if you 
choose to preview the presentation at the end of the publishing process, and is only 
relevant for that purpose. For example, you might publish your files to a network 
location using a UNC address, but the folder to which you publish your files might be 
the home directory for a Web site. In this case, you�d type the URL of the Web site in 
the Playback Presentation Address (Optional) box. 

6. If you are publishing to a Windows Media server, click the Publish Windows Media 
Files To check box. Type the URL of the path to which you�d like the Publish Wizard 
to copy your Windows Media files. For example, if the location of the streaming 
server has the alias MarketingDept, you would type 
http://WMServer/MarketingDept. 

In the Playback Address For Windows Media Files box, type the URL of the 
publishing point from which your Windows Media files will be streamed. Windows 
Media servers require the mms protocol. For example, the URL of the 
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MarketingDept publishing point would probably be something like 
mms://WMServer/MarketingDept. 

7. If you want to provide a Web discussion server by using Office Server Extensions or 
SharePoint Portal Server, click the Discussion Server Address check box and type 
the URL of the discussion server. 

8. If the server to which you are publishing requires you to log on, click the check box 
labeled This Server Requires Me To Log On. Enter the appropriate logon information 
in the User name and Password boxes. Click the check box labeled Remember My 
Password if you would like Producer to save this information for this Web server. 

Click Next to proceed to the Web Publishing Destination page, which is shown in 
Figure 6-20. 

 

Figure 6-20   The Web Publishing Destination page. 

9. Type a name for your presentation in the File Name box. The wizard provides the 
project name by default. 

10. If it isn�t already selected, click Upload Files Now To Web Host. Verify that the 
correct path is displayed in the Publish Files To box. 

Click Next to proceed to the Presentation Information page. 

11. In the Title box, type a title for your presentation. 

Optionally, provide the name of the presenter, a path to an image, and a description. 
All these will be added to the introduction page when the presentation is published 
and will be visible to the viewer. 

Click Next to proceed to the Playback Quality page. 
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12. Select at least one playback quality profile. The Publish Wizard will offer you only 
profiles that are appropriate for the type of content in your presentation. Since 
you�re publishing for the Web, make sure one profile is checked that uses a low bit 
rate, such as For Target Audience Playback At 33.6Kbps. 

Click Next to proceed to the Publish Your Presentation page. 

13. If you�re the curious type, click List Files To Be Published. A separate window opens 
that displays the file name of each file that Producer creates and/or copies to the 
publishing destination folder. Click OK when your curiosity has been satisfied. 

14. Read the Publish To path, which is displayed near the bottom of the Publish Your 
Presentation page, and verify that it is correct. If you want to make any changes, 
now is the time to click Back. 

15. Click Finish. The two progress bars near the top and middle of the page display the 
current condition of the publishing process, and the Publish Wizard also displays the 
estimated time remaining until completion. 

16. When the publishing process is complete, the Publish Wizard allows you to preview 
your presentation. Click Yes in the window that asks, �Would you like to view your 
published presentation?� Be sure to pay attention to the speed at which the 
presentation loads and plays from this point forward, since you might want to make 
changes based on the performance you observe. 

The introduction page for your presentation will open in a separate Internet Explorer 
window. 

 

Figure 6-21   The presentation�s introduction page displayed in Internet Explorer. 

Click Play to view your published presentation. When you have finished watching, 
close the Internet Explorer window. Then click Close to exit the Publish Wizard. 


